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Mobile Widget (Japanese)

Paste widgets to Standby to access information or tools
from Standby.

Network Widget

Some widgets may periodically connect to network, incurring packet
transmission fees.

@ During transmission, other functions (e.g. Video Calls) may be disabled.

M Show/Hide Widget
> In Standby, (=)

Using Widgets
I Pasting Widgets to Standby

Paste up to five widgets per sheet. Select from four sheets
and organize sheets by theme.

1 Pressand hold [J(MULTI/@y)
Widget List appears.

2 Select a widget - (¥7)[Menu] -
Paste on Stand-by — Select a sheet
3 € tomove to target location = (¢)

I Delete Widgets on Standby Display
>Main Menu b Widget > Settings p> Delete Content
P> Select a sheet B> Check Contents to delete p> (=)[Release] YES

® Alternatively, Main Menu p Widget
» Widget Contents or Main Menu > Data Folder
» Widget to select widgets

® When saving widgets from microSD to Standby, do not remove microSD
Card.




I Activating Widgets
Selecting Widgets in Standby

1 In‘Standby (widgets shown), ®
Pointer ( & ) appears.
@ To disable pointer: or

2 @ to move pointer = Select a
widget
Follow onscreen instructions.

I Toggle Sheets
>In Standby, (8) - (@)[Back] or (a)[Forward]

\H

Selecting Widgets from Widget List

1 Press and hold [J(MULTI/@y) ool S22

Widget List appears.
2 Selectawidget

Widget List

Il Move Widgets in List
> Press and hold [J(MULTI/@) - Highlight a widget = (37)[Move] -
3 to determine a target location = ()[OK]
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I Downloading Widgets I Arranging Widgets in Standby
Main Menu p> Widget 1 Standby, (B) = €39 to move pointer = Highlight a
. i -
1 Widget Store widget —» (=)[Operate]
940P connects to the Network, and download site appears. 2 Select an item (See below)
Follow onscreen instructions.
Installing Widgets Item Operation/Description
Some widgets may require you install them manually; follow steps below: Move > €3 to move to a target location = (o)
= > In download completion window, (7)[Menu] - Install Delete frm > YES
S ® Once installation is completed, widgets appear in Widget List. Widget Standby
= folder in Data Folder includes widgets that are not yet installed. Forward Move overlapping widget to foreground
s Rear Move overlapping widget to background
S Reload i
} < ® Alternatively, Main Menu p> Data Folder b Widget eloa Update widget
-~ » Download Widget b YES to download
7-4
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S! Information Channel/Weather
(Japanese)

Subscribe to content and periodically receive updates. Set
Weather Indicator to appear on Standby.

® Transmission fees apply for updates.

@ Auto download is not available overseas.

I Registering/Canceling

Main Menu » News/Entertainment »> S! Info Ch./Weather

1 Register/Cancel - YES

940P connects to the Network.
Follow onscreen instructions.

I Using S! Information Channel
® Up to seven updates are saved.

Viewing New Information
When information arrives, j; and Event
Indicator appear in Standby.

1 InStandby, ®) > 63 tomove
pointer = Select Event Indicator

2 @ [Select]

Follow onscreen instructions.
® Option Menu Items (C%P.7-8)

Il Manually Retrieve Information
Select Event Indicator " Failed to download"
® Alternatively, Main Menu p> News/Entertainment
p S! Info Ch./Weather p> Get Latest Contents > YES

I Delete Information
> Main Menu P> News/Entertainment > S! Info Ch./Weather
> Highlight What's New? > (xJ[Menu] > Delete b YES

® Alternatively, Main Menu p News/Entertainment
p S!'Info Ch./Weather p> What's New? to retrieve information
@ |f there is unread information in both S! Quick News and S! Information

Channel, ieg does not appear. Only Event Indicator appears.

Viewing Previously Received Information

Main Menu » News/Entertainment »> S! Info Ch./Weather

History — Select a date
‘AE for unread news and w for read news appear.

Il Delete History

> Main Menu P> News/Entertainment p> S! Info Ch./Weather
History > (Highlight a History) » (3)[Menu] b Delete or Delete all
> YES
( > For Delete all, enter Phone Password)
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I Using Weather Indicator
Weather Indicator for current forecast area appears.
Viewing New Information

Event Indicator and Weather Indicator appear for weather
updates.

1 In‘Standby, (®) - €39 to move pointer = Select Event
Indicator or Weather Indicator

2 (®)[Select]

Information appears.
Follow onscreen instructions.
@ Option Menu Items (C%P.7-8)

Weather Indicator

Indicators are updated periodically.

Example: ‘@ Clear, @ [> 7 Rain later thunderstorm,

se)y/4 Cloudy with occasional snow, etc.

® See Weather Indicator List (C%P.19-24) for a complete list of indicators.

B Manually Update Weather Indicator

Select Event Indicator " Failed to download”

® Alternatively, Main Menu p> News/Entertainment
p S! Info Ch./Weather p> Weather Indicator p> Manual Update
» YES

M Hide Event Indicator
> Main Menu P> News/Entertainment > S! Info Ch./Weather
p Weather Indicator B> Missed Event Settings p> OFF

® Alternatively, view forecast details from Main Menu
» News/Entertainment p> S! Info Ch./Weather p>
Weather Indicator > Weather

Hiding Weather Indicator

Main Menu p News/Entertainment > S! Info Ch./Weather
p> Weather Indicator p> Display Settings

OFF
® \When Display Settings is set to OFF, update is also deactivated.

JuaLIUIRYIRIUT/SMAN | 00
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I Option Menu Items

While viewing a content, press (37)[Menu] for these options.

Item Operation/Description

Forward GO to next page

Text Copy Copy page text

Select File  View, play or save file to Data Folder (From Step 2 in
Downloading Image/Sound Files: %P.14-11)

Jump in this  Jump to top/end of page
page

Yahoo! Keitai View top menu

Font Size* Change character size

Exit viewing  Exit content
this

* Linked with Font Size setting in Internet option menu.

\H

S! Quick News (Japanese)

Add news headlines, weather forecasts, etc. via S! Quick

News List to scroll across Standby Window.

® Registering or viewing S! Quick News incurs transmission fees. No fees
apply for viewing ticker information. For more information, visit
SOFTBANK MOBILE Corp. Website (http://www.softbank.jp).

I Registering S! Quick News Items

® Register one Quick news, up to four General news and one Special
news.
® Auto download is not available overseas.

Main Menu P> News/Entertainment > S! Quick News
p> S! Quick News List

Add News = YES

Yahoo! Keitai connects and contents list appears.

2 Select an item

Follow onscreen instructions.
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I Opening New Information

Viewing New Information in Standby
When new information is received, @ appears in Standby.

1 In‘Standby, (®) = €39 to move pointer — Select ticker

2 @ [Select]

Content list appears.

3 Select information
Details appear.

P ecccccccccccccccccccce

ITITD @Tum Back Light Off after All S! Quick News Viewed (Z%P.18-6)
@Show Only Unread Items in Standby @Change Marquee Speed
@Hide S! Quick News @Show Image Data (%P.18-16)

Opening S! Quick News List

Main Menu p» News/Entertainment p> S! Quick News
p S! Quick News List

1 Select an item
Content list appears.

2 Select information
Detailed information appears.

3 To connect to the Network, select a title = YES

M Update Manually
> In Step1, ()[Menu] = Update or All Update - YES

I View Summary
> In Step 1, highlight information = (37)[Menu] = Summary Display

I Delete Registered Items
> In Step 1, (highlight information =) (x7)[Menu] - Delete or
All Delete - YES (= For All Delete, enter Phone Password)

JuaLIUIRYIRIUT/SMAN | 00

® Alternatively, Main Menu p News/Entertainment
P> S! Quick News p> Settings p> Del S! Quick News List
P> YES to delete all information

P ecccccccccccccccccccoe

ETIFD @Automatically Update S! Quick News List
@Delete S! Quick News Information (c%P.18-16)

8-5



JuUaLIUIRYIRIUT/SMAN |00

8-6

E-Books (Japanese)

Use BookSurfing® to acquire/view e-books, comics, photo
books, etc. or e-Book Viewer to view XMDF files on 940P.
® BookSurfing® and e-Book Viewer are S! Appli.

® Download Content Keys (%P.9-5) to read CCF/XMDF files.

® Some copy protected files have extensions different from the ones below.

Application

File Format

BookSurfing®

CCF (.ccf)

e-Book Viewer

XMDF (.zbf, .zbk, .zbs)

@ Some PC content may not be viewable via e-Book Viewer.

Main Menu p» News/Entertainment

1 BookSurfing or e-Book Viewer
@ See application Help menu for usage information.

® Launch BookSurfing®/e-Book Viewer via S! Appli, or select a file from
Books in Data Folder.

® \When purchasing a new handset, move CCF/XMDF files via microSD
Card. However, if CCF/XMDF files are copy protected, Content Keys
backup may be needed (£%P.10-22). Some contents require another
Content Key after being moved/copied to a new handset or can not be
moved/copied at all.




Blogging
Save blog details to update or view blogs.
@ Save up to 20 blog details.

ISaving Blog Details

Main Menu p News/Entertainment > Post Blog
1 (&) [New] = Select an item (See below)

Item Operation/Description

Service name Save a blog service name
> Enter a service name

Blogger Save a mail address for posting by mail

address > Enter a mail address

Mail title Save a title to enter automatically when posting by mail
> Enter a title

Yahoo! Keitai Save a URL for posting from Yahoo! Keitai

URL > Enter a mail address

PC Site Save a URL for posting from PC Site Browser

Browser > Enter a mail address

p) (=)[Finish]

\H

I Posting to Blogs

Main Menu p News/Entertainment > Post Blog

Posing by Mail
Highlight a service = (9)[Post] = Compose a
message (C3From Step 4 on P.14-4) - [=[Send]

Posing from Yahoo! Keitai/PC Site Browser
Highlight a service = =)[To site] = By Yahoo!
Keitai or By PC Site Browser - YES

940P connects to the Network and website appears.
Follow onscreen instructions.

[ Post Captured Images to Blogs
> While a captured image is shown, or highlight an image in Data Folder
— (¥7)[Menu] = Post blog* = Follow Step 1 above
* Some images may not be posted (e.g. images opened from Data Folder by
pressing (&)[Folder] in Picture Viewfinder)
® Set Auto save set (C5P.18-16) in Camera menu to OFF to post images
to blogs easily.

JuaLIUIRYIRIUT/SMAN | 00
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I Blogging Functions
(From Jp Main Menu p> Settings b Post Blog

M Edit Service Information
> Highlight a service - (al)[Edit] - Edit

I Delete Service Information
> Highlight a service = (7)[Menu] - Delete -
Select an item (See below)

Item Operation/Description
Delete this > YES
Delete > Check services = (=)[Finish] = YES
selected

Delete all > Enter Phone Password = YES
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Overview

Play music saved on 940P/microSD Card.
® Play List: %P.8-10

Notes

@ Files may not play due to file support issues or microSD Card status, etc.
® When playback starts with low battery, confirmation appears.
When battery is low during playback, confirmation appears.
® Playback pauses for incoming calls or Alarm. Playback resumes after calls
are received or Alarm sounds.

Music lllumination

@ Notification Light illuminates when playback starts. When playback
starts during charging, Music lllumination lights before Charging
Indicator.

® To turn off light, set Music to OFF in Notification Light setting
(C%P.18-10).

BfPecccccccccccccccccccce
@Use Bluetooth® Device for Wireless Playback (£%P.10-10)

Saving Music

Save Music to play on Music Player.

Download
Chaku-Uta Full®
(C>P.8-3)

Open site link to download and save songs

Supported file format: SMC, MPEG-4
(MPEG-4 AAC, MPEG-4 AAC+ (HE-AAQ),
Enhanced aacPlus)

Save Music via
SD Audio (C*P.8-3)

Save music CD songs via PC to microSD Card in
AAC format

Supported file formats: MPEG-2 AAC,
MPEG-2 AAC+SBR

Save WMA files
(C%P.8-4)

Save Windows Media® Audio (WMA) files in PC
to microSD Card via Windows Media® Player

Supported file formats: WMA

® Some files may not play even if format is supported.

Copy Protected Files

Copy protected files may not play, be saved or forwarded.

To play a copy protected file, obtain Content Key (C3P.9-5).
Confirm file expiry date or usage limitations (Music info: £%P.8-8).




Saving Music Files on PCs
When saving music files for use with 940P, observe the following
guidelines:
® Copyrighted Works
- Do not infringe on third party/intellectual property rights.
- Music files are limited to private use.
@ Obtain software to convert file format.
- Refer to websites providing software.
- Performance of some software types is not guaranteed.

I Downloading Chaku-Uta Full®

Access websites directly from Music Player to download
Chaku-Uta Full® files.

® View details (price, expiry date, etc.) on source website.

Main Menu p> Music Player p> Data Manager »> Main Folder
» Download Music

YES

940P connects to the Network and Download site appears.
@ Follow onscreen instructions to download files.

\H

I Saving Music Files by Using SD Audio

Note
@ Saving music files requires following:
- 940P
- microSD Card (commercial item)
- USB cable (not included)
- PC (Windows® XP, Windows Vista®)
- Software for PC (commercial item)
Panasonic brand "SD-Jukebox" is recommended. Purchase
SD-Jukebox from website below:
http://club.panasonic.jp/mall/sense/ (Japanese only)
- Music CD to save

Main Menu p- Settings »> Connectivity » USB Mode
» microSD Mode

1 Connect 940P to a PC via USB cable

Activate SD-Jukebox on PC

® Alternatively, follow these steps to access Download site:
Main Menu p- Data Folder p> Music »> Main Folder
» Download Music p> YES

Save music files to micro SD Card

® See SD-Jukebox manual for usage information.
® After saving, release USB cable from 940P.

2
3 Set a music CD on PC
4
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I Transferring WMA Files

Transfer WMA files from PC to microSD Card via Windows

Media® Player. Up to 1000 files can be saved per microSD

Card.

® Use PC with Windows Media® Player installed.

® When using Windows Media® Player 10 (10.00.00.3802 or later)/11 on
Windows® XP, use Windows® XP Service Pack 2 or later.

® When using Windows Vista®, use Windows Media® Player 11.

@ Insert microSD Card into 940P before preparing USB cable (Transferring
Data via USB Cable: c%P.10-12)

Main Menu p> Settings P> Connectivity » USB Mode
» MTP Mode

1 Connect 940P to a PC via USB cable

Follow Windows Media® Player operations to transfer WMA files from
PC to microSD Card.

® Refer to Windows Media® Player Help for operations.

® Terminate all software applications before disconnecting USB cable.

\H

_Note |

® Do not remove microSD Card while transferring files to microSD Card.
Files may be damaged.

® \WMA files overwrite existing files with same name in handset when
copied from PC. To check file names, refer to Windows Media® Player
Help.

® 940P may not recognize WMA files saved to a microSD on a different
handset. Handset may not recognize WMA files from PCs if USB Mode
is set to MTP Mode. Delete WMAudio and WMSystem folders in My
[tems (MY FOLDER) on microSD, or format microSD Card (C%P.9-18) via
PC. Formatting microSD deletes all saved files.

® To play WMA files on handset, save files to WMFile (£%P.9-20) on

microSD Card and play the files from PC Movies folder in Data Folder.




Using Music Player

I Playback Window Indicators

Now Playing

Item

Description

File Number/Total Number

Title

Artist

Status

Elapsed Time/Total Time

@000 0e

Play Mode Indicators

Play only one Repeat one
Repeat all Random
EZ] Random play&repeat

DEMO

@ | Equalizer Setting Normal H.BASS1
H.BASS2 Train

@ | Stereo/Monaural Stereo Monaural

@ Listening Setting Surround-sound
Natur 1
Natur 2

®| Remaster Setting ON | —

® | Bluetooth® Device —

Connected

®| Volume —

®| Lyric —

®| URL —

9-5
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I Playing Music

Main Menu P> Music

1 Player
. [TTEALI Tracks ]
Player Menu window appears. BlSArtist
@ Last playback window appears. EQL:HBD

To open Player menu: twice. EizPlay List
()[Menu] - Player menu to show

Player Menu Window
Player Menu window. y

2 Select a category (See below)

® mp4/3gp files in Ring Songs&Tones folder can also be played in Music
Player.

Changing Play Mode
1 Player

Player Menu window or Playback window appears.

2 (¥)[Menu] -+ Play mode setting

3 Select an item (See below)

Item Operation/Description

Item Operation/Description Normal Play all files in selected category/Play List
All Tracks Select files from 940P & microSD Card Play only one Play selected file
Play List Select group of files saved to Play List Repeat one  Repeat selected file
Artist Select files from Artist folder Repeat all Repeat all files in selected category/Play List
Album Select files from Album folder Random Play selected category/Play List files randomly
Genre Select files from Genre folder Random Repeat selected category/Play List files randomly

play&repeat

® >k appears for currently/previously played Play List.

3 Select a file

Selected file plays.

®  appears for currently/previously played file.
® Playback Window Operations: C3P.8-7

® To end playback, (=) CH]




Using Other Functions while Listening to Music
(Play Background)

Use Phone Book, Messaging, Internet, etc. while listening to music.
1 While playing file, (€a)[BGM]
2 Toend, in Standoy = End player

® Some functions cannot operate simultaneously.
@ \/olume or play mode change is not available during Play Background.

Playing Chaku-Uta Full®/WMA Files as Demo

Main Menu » Music p> Data Manager

1 Select an item (See below)

Item Operation/Description
Main Folder  View Chaku-Uta Full® list
> Select a folder
@ To view file list in handset/microSD Card:
(@)[Phone/microSD]
WMA View WMA list
® (a)[Change] to toggle display view in Chaku-Uta Full® and WMA
list.

2 Select a Chaku-Uta Full® or WMA file

Demonstration playback starts.

\H

I Playback Window Operations

Adjust Volume

@ or WM

Play Previous*

@) or press and hold [

® \When playback time is over
three seconds, previous file
plays from beginning.

Play Next* (9 or press and hold [
Rewind Press and hold ©)
Forward Press and hold (%)
Pause/Resume Ol n I » |
Stop (=)

View Next Jacket/Lyric

View Previous Jacket/Lyric

Switch Jacket/Lyric Display
‘S,vv;l;tdc:v\l:jayllst/Playback @)List/Player]
Play Background* (O)[BGM]

Switch Remaster (% P.8-8) D)

Switch Listening (> P.8-8)

Switch Equalizer (% P.8-8)

* Not available for playback as a demo
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I Functions while Playing Files

I Set Sound Effect
> While playing file, (x7)[Menu] = Sound effect = Select an item

I Functions Available in Playback Window
> While playing file, ()[Menu] = Select an item (See below)

Item Operation/Description

Player menu Show Player menu

(See below) Play mode  Change play mode (C%P.8-6)
Item Operation/Description setting
Remaster Complement sound from earphone or Bluetooth® device Sound effect (C¥lef)
to bring close to original sound Music info Show song title, artist and playback time
> ON or OFF Connect to  Open site link
Listening Add listening effect to sound from earphone or Bluetooth® | Website > YES
device . Display Image Show jacket
n > Select an item Display Ivric  Show Ivi
- Surround-sound’: Reproduce natural and Isplay fyric ow iync
= stereophonic sound Previous image/ Show previous jacket or lyric
E_ - Natur 1 or Natur 2: Complement sound specific to | _Previous lyric
% earphone to reproduce natural sound Next image/  Show next jacket or lyric
) - OFF: Turn off Listening setting Next lyric
E Equalizer Change quality of sound from earphone or Bluetooth®

device
> Select an item
- Normal: Reproduce normal sound
- H. BASS1: Enhance low-pitched sound
- H. BASS2: Enhance low-pitched sound even more
- Train: Minimize sound leakage

9-8




| Chaku-Uta Full®/WMA List

(From Jp Main Menu p> Music p> Data Manager
M Confirm Memory Status

Item Operation/Description

Move to Move a Chaku-Uta Full® to microSD Card
microSD '

Add folder ' > Enter folder name

Multiple- Select multiple Chaku-Uta Full® files
> (2)[Menu] -+ Memory Status choics* > Check Cf?aku—Uta Full® files = (x7)[Menu] - Delete,
M Functions Available in Chaku-Uta Full® Folder List Move or Send Ir data - Operate selected item
> Main Folder — Highlight a folder - (7)[Menu] = Select an item Connectto  Opensite link
(See below) Website ' >YES
Item Operation/Description Display image Show jacket
Add folder > Enter folder name Memory Memory status/total number of files appears
Edit folder > Enter folder name Status
TETTE DEL all Delete all WMA licenses
Delete folder > Enter Phone Password - YES REEEE 2_ > Enter Phone Password - YES
Memory > Confirm memory status/total files BECIENEN > YES
Status Delete all Delete all files in folder
> Enter Phone Password = YES
M Functions Available in Chaku-Uta Full®/WMA File List Attach to Send a file via S! Mail (C3From Step 2 on P.13-4)
> Main Folder or WMA (= Select a folder) = Highlight a file = S! Mail !
(x)[Menu] — Select an item (See below) Send Ir data ' (C%P.10-3)
Item Operation/Description IC (%P.10-5)

Set as ring Set Chaku-Uta Full® as ringtone
tone (Fullsong > Fullsong ring tone — Select an item
ring tone) '

transmission '

Take contents (C%P.9-5)
key '

Setasring  Seta segment of Chaku-Uta Full® as ringtone
tone (Point > Point ring tone — Select a segment = Select an
ring tone) ' item
® To confirm segment: (=)[Play]
Music info  Show song title, artist and playback time
Move ' > Select a storage

! Chaku-Uta Full® files only
2 WMA files only
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I Using Play List

Use Play List to organize Data Folder music files.
Select Music folder files to create Play List links to each file
in its original folder.

Creating New Play Lists

@ Save up to 30 Play Lists with up to 100 songs per list.
® Music files saved on microSD Card are also savable.

Main Menu > Music

1 Player

Player Menu window or Playback window appears.
@ When Playback window appears, (37)[Menu] = Player menu to
show Player Menu window

D Play List » (x7)[Menu] - :
;
Create play list = Select a Bl Gkeitai-001

category and show file list = Check TBD
files to save to Play List =

[FiniSh] Play List Window
3 Entera Play List name

@ Play List

® Create WMA Play Lists (using Windows Media® Player) or SD Audio Play
Lists (using SD-Juke Box) on PC. Maximum number of Play Lists to
create and songs to save is as follows:
WMA Play Lists: 100 Play Lists; 250 songs per list
SD Audio Play Lists: 99 Play Lists; 99 songs per list

Playing Songs from Play List

Main Menu P Music

1 Player

Player Menu window or Playback window appears.
@ When Playback window appears, (3)[Menu] = Player menu to
show Player Menu window

2 i
2 Play List = Select a Play List e

® To play back selected Play List from the Eﬂlﬂ 509-06-06-002

beginning: (=)[Play] .0 i
3 Select a file
Selected file plays back. Play List Contents

Window

® mp4/3gp files in Ring Songs&Tones folder can also be added to Play
List.




I Play List

Main Menu > Music p> Player
(» ()[Menu] p> Player menu) p> Play List

M Functions Available in Play List Window
> (Highlight a Play List) (7)[Menu] — Select an item (See below)

Item Operation/Description
Music info  Show song title, artist and playback time
Add Add files to Play List

> Select a category, and show contents window —
Check files to add (=)[Finish]

DEL from Delete files from Play List
play list > Select an item = Operate selected item

Item Operation/Description

Player menu Open Player menu

Order to play > Select a file from Play List to change playing order =
@ to change order = ()[Select]
® Repeat steps above to change order = (=)[Set]

Play mode  Change play mode (%P.8-6)
setting

Create Create a new Play List (C3P.8-10)
play list

Add to
play list

Add files to another Play List
> Add one or Add some (- For Add some, check
files = (=)[Finish]) = Select a Play List

Copy play list Copy Play List
> Enter a Play List name

Display image Show jacket

Edit pl. list  Edit Play List name
name > Edit Play List name
Add Add files to Play List
> Select a category, and open a Play List = Check files
to add - (=)[Finish]
Delete > Select an item = Operate selected item
play list

M Functions Available in Play List Contents Window
> Select a Play List = (Highlight a file) » (x7)[Menu] — Select an item
(See below)

Item Operation/Description

Player menu  Open Player menu

Play mode  Change play mode (£%P.8-6)
setting

1ahe|d d1sniy E
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Data Folder

Save, play and manage files downloaded from Internet, etc.
® Save still images/videos captured by Camera, downloaded data or data copied/moved from SoftBank handset to microSD Card.

I Data Folder Structure

Folder Function/Saved Data File Format '
Pictures 2 Download Pictures Connect to download site JPEG, GIF (.gif including
Album-Touch Activate Album-Touch Interlaced GIF),
Main Folder Downloaded still images, etc. GIF Pictogram Package File
Camera Still images captured by Camera, etc. (.gpk), SWF (.swf Flash
My Download My Pict. Connect to download site Animation),
Pictograms | BRICAD Downloaded pictograms, etc. PNG (.png including Interlaced
10 PR T, 58, etc. Preinstalled pictograms PNG)
= Mail Art Mail Art (download) Connect to download site
2 Pre-installed Preinstalled still images
S Original Animation Display still images continuously
5 Ring DL Ring Songs&Tones Connect to download site SMF, SP-MIDI, AMR, SMAF
"?H Songs&Tones * | Main Folder Downloaded ring songs/tones, etc. and MPEG-4 formatted files
= Pre-installed Preinstalled ring songs/tones (.mid, .midi, .amr, .mmf, .3gp,
© Voice Announce Data recorded by Voice Announce .mp4)
Play List Play back Play List
S! Appli ? Download S! Appli Connect to download site -
Widget * Download Widget Connect to download site WGT (.wgt), SWGT (.swat)
Music Main Folder 2| Download Music Connect to download site MP4, SMC, WMA (.3gp, .mp4,
Music Search .smc, .wma)
Initial Folder Downloaded Chaku-Uta Full®
WMA 3 WMA Files transferred from PC
10-2
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Documents ?

Folder Function/Saved Data File Format '
Videos ? Download Videos Connect to download site MP4 (including .mp4, .3gp,
Main Folder Downloaded video files, etc. SDV), ASF (.asf)
Camera Video files recorded by Camera
Pre-installed Preinstalled video files
Play List Play back Play List
Position Memory Play back video files from saved resume position
PC Movies microSD 3 PC movies saved using PC WMA (.wma), WMV (.wmv),
Position Memory Play back PC movies from saved resume position ASF (.asf)
Play History Playback records of PC movies
v Image Still images recorded by Digital TV JPEG (.jpg)
Video 3 Copy-protected video files (One-Seg compatible) TOD (.tod), MOI (.moi),
Position Memory Play back video files from saved resume position MAI (.mai), PGI (.pgi)
Lifestyle-Appli| Download Connect to download site (Osaifu-Keitai®: £%P.16-2) -
Books 2 Download Books Connect to download site CCF (.ccf), XMDF (.zbf, .zbk,
.zhs)
Customized | Customized Screen Connect to download site CUSR (.xcsf)
Screen 2 Familiar Usability
Templates Download Templates Connect to download site -
Font Download Font Connect to download site MTF (.mtf)
Main Folder Downloaded fonts
Pre-installed Pre-installed fonts
Other Main Folder Incompatible files attached to mail ¢ -

! Some copy protected files have extensions different from above.
2 When microSD Card is installed, press (&)[microSD] in Folder list to view data saved in microSD Card.

3 Available only when microSD Card is installed.

4 Some attachment files cannot be saved in Other Documents.

s3|14 buibeuepy | S
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1 Select a folder

Opening Files
IViewing & Playing Files

Main Menu p Data Folder

folder and microSD Card folder.

) Pictures

@Download Pictures
@ In Folder List, press (&) to toggle handset |EF TR am—

ElPCame am
1PNy I:[

EHPMail Art
[@PPre-instal led

Pictures Folder

Select a folder = Select a file I Clnelia
File appears/plays.
® To toggle file list view: (cx)[Change]
Fﬁ@zoo%aoswzsoom
Sz 89
Still Image List
Window

When Shortcut to a Download Site is Selected

Handset connects to a download site on Internet.

I Operations while Playing Back Ring Songs&Tones

\H

I Videos/PC Movies Playback Operation
® Some operations are not available depending on files.
@ Operation descriptions are based on Portrait View.

Adjust Volume @ or @y
©
Play Previous ® Starts from beginning when playback time is
over three seconds.
Play Next €]
Rewind ' Press and hold ©)
Forward ' Press and hold ()

Select Position ?

©) repeatedly

Change Speed | (=) IEN/ IS '/ HC]
Mute/Resume 2 < 0 o
Pause/Resume (o[ I/

Play Frame by While pausing, (=)[Frame]
Frame ' ® Play back frame by frame
Remaster ([3P.8-8) | (9)

Listening (C%P.8-8)

Equalizer (C%P.8-8)

! Videos only
2 PC Movies only

Stop (®)[Stop]
Volume ®/80
Attach files (during playback)

to S! Mail QI =)

P eececcccccccccccccoccccoe
@File Display/Playback Functions (C3P.9-6)



I Copy Protected Files

Playing/forwarding/saving may be restricted and Content

Key (%P.9-5) may be required for usage.

If Content Key is expired, obtain a new Key to use file.

® % or @ (Silver) appears for copy protected files requiring Content Keys.
% files are accessible. @ files are inaccessible. Ed appears on images
in Thumbnail view of expired files (Original icon appears for Books
folder.).

@ When deleting & files or folders containing ‘B files, confirmation
appears asking whether to delete corresponding Content Key. Other files
requiring same Content Key may become unusable.

@ See File Properties to confirm restrictions such as expiry term or usage
limitation (Options: £%P.10-7)

® 940P holds up to 1000 Content Keys. Multiple Keys may be required to
use a file.

® Interrupted playback (by incoming calls or Alarm) of copy protected WMA
files with limited usage in Data Folder is also counted as one usage.

Using Copy Protected Files

@ Files downloaded on 940P cannot be used on PCs.

® Network setting may be required for usage.

@ File usage may require insertion of USIM Card in use at time of
download.

® When set as wallpaper or ringtone, settings may return to defaults if
license has expired or different USIM Card is inserted.

@ Limited use files cannot be set as wallpaper or ringtone.

Content Key
If Content Key is expired, a message appears when the file is opened. To
obtain a new Key, select YES. 940P connects to Content Key site.

® Alternatively, obtain Content Key as follows: Highlight a file =
(¥)[Menu] - Take contents key

® Depending on contents, some Content Keys may not be obtained from
websites even when warning for expired contents appears.

® When 1000 Content Keys have been saved, a message appears. Delete
old Keys; otherwise downloads may fail (Connection fees apply).

s3|14 buibeuepy | S
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I File Display/Playback Functions

M Enlarge Still Images
> Main Menu p> Data Folder p> Pictures p> Select a folder p> Select a
file » (z[Menu] »> Display size ) Fit in display

I Play Back from a Resume Position

Resume playback (videos/PC Movies) from a saved position.

>Main Menu p- Data Folder P> Videos or PC Movies
»> Position Memory b Select an item

@ Save a resume position: C¥Right

® Marker to resume is a resume position automatically saved when a
call comes in, alarm goes off, battery runs low, or playback is terminated.

I Functions Available in Video/PC Movie Playback Window
@ Some operations are not available depending on files.
> While playback is paused, (x7)[Menu] = Select an item (See below)

Item Operation/Description
Normal play ' Play at normal speed
Slow ' Play at slow speed
Quick View  Play 1.25 times faster than normal
(1.25x) !
Quick Play at double speed
View(2x) '
Fast ’ Forward
Rewind ? Rewind
Stop Return to Videos/PC Movies List window
Position to  Start playback from specified point
play > ) to highlight a play point = (*)[Set]
Connectto  QOpen site link
Website ' >YES

Item Operation/Description

Sound effect Remaster, Listening or Equalizer ((%7P.8-8)

Contents info 2 Show title, file name, etc.

Position Save resume position
memory > Select a resume position
® To play back from a saved position: [%Left

Attach to Send file via S! Mail or post on a blog

S! Mail/ > Select an item

Post blog ' - Attach to S! Mail (C5From Step 2 on P.14-4)
- Post blog (5Step 1 on P.8-7)

Register Set as ringtone

(Ringtones) ' > Ringtones — Select a type
® 3 appears for item set as ringtone.

Register Save a file as Standby Display or Start-up Window
(Stand-by > Select an item = YES

Display/Start-up

Window) '

Video info !  Show title, file name, etc.

Send Ir data ' Send file via Infrared (C%P.10-3)

IC transmission ' Send file via IC transmission (C%P.10-5)

Add shortcut Create a shortcut (C%P.1-22)
icon'

Description 2 Show file information
> The words view or Description view

Copy URL?  Copy URL

Display size  Select a display size
> Actual size or Fit in display

Change to Switch to Landscape View. Full screen playback starts.
full ! ® To toggle views: (@)

! Video files only
2 PC movies only

PR



I Options : Item . Operatiop/Description .
Slideshow  Show files in a folder continuously. Select display speed
Highlight a file in Data Folder = (x7)[Menu] for the following operations. > Normal or Slow
@ Some functions may not be available depending on files. Delete this  Delete a file
. >YES
M Pictures Delete all Delete all files
Item Operation/Description > Enter Phone Password = YES
Edit picture  Edit files ((%P.9-12) Multiple- Select multiple files to use
Display picture Open files choice > Check files to use = (x7)[Menu] = Select an item
Set display*  Set as wallpaper, Phone Book image, Menu Icons, etc. Memory Show memory information
> Select an item Status
® 5 appears for item. Sort Change display order of files
Picture info  Show file name, file size, etc. > Select an order
Attach to Send files via S! Mail (3From Step 2 on P.13-4) Pictures/ Toggle list view
S! Mail File names ® Alternatively, (@)[Change] to toggle
Graphic mail Add selected files to Graphic Mail (%P.13-9) Take contents Connect to site for Content Key
Post blog Post file on a blog (C%P.8-7) key
Send Ir data  Send files via Infrared (C%P.10-3) * Before setting a file as Video Call related item (except for Incoming/
IC transmission  Send files via IC transmission (C%P.10-5) Outgoing Video Calls), set Select Images to Original (Change Outgoing
Add shortcut Create shortcuts (#P.1-22) Image: C5P.18-12).
icon To set a file as Menu Icon related item, set Menu Icons to Customize
Copy to Copy files to microSD Card (%P.18-4).
microSD @ [f incoming calls arrive or handset is turned off while My Pictograms
Move to Move files to microSD Card package file (.gpk) is being uncompressed, some pictograms in package
microSD file may not open. Retry uncompressing.

Positioning

Set where to paste files in Standby
> Select a position

Edit file name Edit file names

Move

Move files to other folders

PR

P eececcccccccccccccoccccoe

@¢tnlarge Still Images (5P.9-6)

@Etditing Still Images (C%P.9-12)

@Creating Animations (C%P.9-13)

@Saving Still Images to Phone Book (%P.9-14)

s3|14 buibeuepy | S
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I Ring Songs&Tones B Widget
Item Operation/Description Item Operation/Description

Edit file name Edit file names Paste on (¥P7-2)
Play melody Play back files Stand-by
Setasring > Setas ringtone Widget Show file names, sizes, etc.
tone ® Y appears for item. Information
Add shortcut Create shortcuts (%P.1-22) Attach to Send files via S! Mail (%From Step 2 on P.13-4)
icon S! Mail
Attach to Send files via S! Mail (C%From Step 2 on P.13-4) Send Ir data  Send files via Infrared (£%P.10-3)
S! Mail IC Send files via IC transmission (£%P.10-5)
Send Ir data  Send files via Infrared (C%P.10-3) transmission
IC Send files via IC transmission (C%P.10-5) Move to Move files to microSD Card
transmission microSD
Copy to Copy files to microSD Card Delete this  Delete afile
microSD >YES
Song-Tone  Show titles, file names, etc. Delete all Delete all files
info > Enter Phone Password = YES
Memory Show memory information Multiple- Select multiple files to use
Status choice > Check files to use = (¥7)[Menu] - Select an item
Delete > Select a type

- Delete this = YES

- Delete select = Check files to delete -

(=)[Finish] - YES

- Delete all = Enter Phone Password = YES

Sort Change display order of files
> Select an order

Move Move files to other folders
Move to Move files to microSD Card
microSD
Take contents Connect to site for Content Key
key




I S! Appli/Lifestyle-Appli

Item Operation/Description

Item Operation/Description

Start Activate S! Appli or Lifestyle-Appli

Add shortcut Create shortcuts (C%P.1-22)
icon

Security level Set security level ((%P.15-4)

Edit file name Edit file names

S! Appli info  Show file names, file sizes, etc.

Add shortcut Create shortcuts (C%P.1-22)

Delete this  Delete a file
>YES

Delete all files
> Enter Phone Password = YES

Delete all

Multiple- Select multiple files to use
choice > Check files to use = (¥7)[Menu] = Select an item
Memory Show memory information
Status
Sort Change display order of files
> Select an order
Listing Change list view

® (a)[Change] to toggle views

Take contents Connect to site for Content Key
key

icon

Move to Move files to microSD Card

microSD (Lifestyle-Appli cannot be moved)

Delete Delete files

>YES

M Music

® See "Functions Available in Chaku-Uta Full®/WMA File List" (C%P.8-9)
M Videos

Item Operation/Description

Register Set as ringtones, Standby Display or Start-up display
Video info Show titles, file names, etc.

Attach to Send files via S! Mail (C%From Step 2 on P.13-4)

S! Mail

Post blog Post file on a blog (C%P.8-7)

Send Ir data  Send files via Infrared (C%P.10-3)

IC transmission Send files via IC transmission (C%P.10-5)

Copy to Copy files to microSD Card
microSD
Move to Move files to microSD Card
microSD
Move Move files to other folders

s3|14 buibeuepy | S
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I PC Movies M Books
Item Operation/Description Item Operation/Description
Contents info Show titles, file names, etc. Play Play back files
Move Move files to other folders Connectto  Open site link
Copy Copy files to other folders Website
Multiple- Select multiple files to use Book info Show file names, file sizes, etc.
choice > Check files to use = (¥7)[Menu] = Select an item Copy to microSD Copy files to microSD Card
Comment Show descriptions Move to microSD Move files to microSD Card
view Add folder  Add folders
Memory Status Show memory information Edit file name Edit file names
Delete this  Delete a file Move Move files to other folders
> YES Take contents Connect to site for Content Key
10 Delete all Delete all files key
= > Enter Phone Password = YES Delete Delete files
g mTv >YES
@. ® See Pictures folder for still images.
3 Item Operation/Description
s} Edit title > Enter titles
2 Video info Show titles, channel names, etc.
Add shortcut Create shortcuts (%P.1-22)
icon
Delete > Select an item
- Delete this - YES
- Delete selected = Check files to delete =
(=)[Finish] - YES
- Delete all = Enter Phone Password = YES
Memory Status Show memory information
Listing Change list view
® ()[Change] to toggle views
10-10
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M Customized Screen M Templates
Item Operation/Description Item Operation/Description
Preview Preview files Compose Send files via S! Mail (3°P.13-5)
Collective  Set Customized Screen all at once S! Mail
Setting Edit title Edit titles
File info Show titles, file names, etc. Template Info Show title and file size
Copy to microSD  Copy files to microSD Card Delete this > YES
Move to microSD Move files to microSD Card Delete > Check files to delete - (=)[Finish] - YES
Edit file name Edit file names selected
Delete this  Delete afile Delete All > Enter Phone Password = YES
>YES
Delete all Delete all files M Font
> Enter Phone Password = YES Item Operation/Description 10
Multiple- Select multiple files to use Set A
. . ) pply selected font
h Check files to use = (7)[M Select an it o : - =
} choice = Check files .O use .[ enu] = Select an item File info Show file names, file sizes, etc. Q
Memory Show memory information — — 5
Status Edit title Edit titles Q.
Sort Change display order of files Delete this  Delete a file a
> Select an order > VES : =
Listing Change list view Delete all Delete all files o
e (ta)[Change] to toggle views — >|Enter F’lhoTefF]assvvord - YES
; Multiple- Select multiple files to use
Tak tents C t to site for Content K R ) .
kae contents Lonnect fo site for Lontent ey choice > Check files to use = (¥7)[Menu] = Select an item
Connectto  Open site link gllte:'lory Show memory information
Website atus
Sort Change display order of files
> Select an order
Listing Change list view
@ (a)[Change] to toggle views
10-11
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Using/Editing Still Images

Item Operation/Description
File info Show file names, file sizes, etc. I Editing Still Images
iles via S! Mai B
?rtsg;lto Send files via 5! Mail (CrFrom Step 2 on P.13-4) ® Edit features are not available for all file types.
Copy to Copy files to microSD Card Main Menu b Data Folder p> Pictures
microSD :
Edit file name _Edit file names Select a folder = Select a file = (x7)[Menu] =
Move Move files to other folders Edit picture
Delete this Delete a file )
> YES 2 (x7)[Menu] = Select an item (See below)
Delete all Delete all files
10 > Enter Phone Password = YES Item Operation/Description
Multiple- Select multiple files to use Marker stamp > Selectg stamp — ) to move stamp — @ [lPut]
§ choice > Check files to use = (7)[Menu] = Select an item @ Following options are available when positioning a
3 : : stamp:
Memor Show memory information
@. Status Y ! - To rotate or scale up/down: ()[Menu] =
@  sort Change display order of Select an item
- >£§ lget °P aydo erorties - To start over: (=)[Cancel]
& clecan ot ® To add: (&)[Add]
Frame > Select a frame
@ Titles of mp4/3gp Ring Songs&Tones files and Videos/Music/Customized - To rotate 180 degrees: (7[Menu] -
Screen files appear in respective lists. Files without titles appear with 180° rotation
file names (created when files are saved to handset). Titles cannot be - To change frame: @
changed; edited file names may not appear in lists. - To return to frame list: (&)[Cancel]
Character > Enter text — €3) to move text » (¢)[Put]
stamp @ To change content/color/font/size: When positioning
stamp, (7)[Menu] — Operate selected item
® To start over: (&)[Cancel] after positioning
10-12
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Item

Operation/Description

Fit in screen

Change image size to Standby (480 x 854)
>YES

Change size

> Select a size
® To start over: (&)[Cancel]

Trim away > Specify a size = €3 to specify area = (o)[Set]
® To start over: After specifying area, (=&)[Cancel]
Retouch > Select an item
® To start over: (&)[Cancel]
Rotate > 90° to right, 90° to left or 180°
® To start over: (&)[Cancel]
Brightness > () to adjust brightness
Attach to Create S! Mail with edited still images
S! Mail* > (o)[Set] - Create S! Mail (C%From Step 2 on P.13-4)
® Edited files are automatically saved.
® Alternatively, (=)[ IE<I] to attach pictures to S! Mail
Attach to Send file via S! Mail or post on a blog
S! Mail/ > Select an item
Post blog* - Attach to S! Mai - (*)[Set] = Create S! Mail
(C%From Step 2 on P.14-4)
- Post blog - (*)[Set] = Post on a blog(%P.8-7)
® File is automatically saved with another file name
® Alternatively, (=2)[ BEXM] to attach to S! Mail
Save* Overwrite/rename to save edited files

* Available after other editing operations.

3 (®iset] » (2)[save]

4 YES (Overwrite) or NO (Save as)

I Creating Animations

Saving Original Animation

Main Menu - Data Folder p> Pictures p> Original Animation

1 <New> = <1st> - <20th>

2 Select a folder = Select a file
® Repeat Step 2.

3 (=[Finish]

Functions Available in Original Animation List

In Original Animation list, press (37)[Menu] for following operations.

Item Operation/Description

Edit title > Enter title

Org. animation Add more files to an Original Animation (C¥Above)

Display Play back an Original Animation

picture @ Alternatively, select an Original Animation from list to
play back.

Set display Set an Original Animation as Standby display, etc.

> Select item to set Original Animation as

Picture info  View item set for Set display

Release Cancel a saved Original Animation

animation >YES

s3|14 buibeuepy | S
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ISaving Still Images to Phone Book

® Savable sizes:
- Standby (480 x 854) or smaller in JPEG or GIF format (up to 300 Kbytes)
- VGA (640 x 480) or smaller in PNG format

® Save images to up to 100 Phone Book entries.

@ Still images cannot be saved to USIM Card Phone Book entries.

Main Menu p> Data Folder P> Pictures
Select a folder — Select a file = (x7)[Menu] -

Set display - Phone Book
10 New Entry
= New - Enter details (= From Step 3 on P.4-4) =
3 (&)[Finish]
Q
%- Add to Existing Entry
S Add - Select entry —» (=2)[Finish] - YES
o
10-14

Managing Folders/Files
I Managing Folders

The following operations are available in Pictures, Music,
Books, Videos, Ring Songs&Tones and Other Documents.

Main Menu > Data Folder

Select a folder = [Menu] — Select an item
(See below)

Item Operation/Description

Add folder  Create user folders

Edit folder  Edit user folder names
name

Delete folder Delete a user folder
> Enter Phone Password = YES = YES

Folder Hide files in folder unless Phone Password is entered
security ' > Enter Phone Password = YES

{2 appears for folder.

@ To cancel: Repeat the step

Delete all > Enter Phone Password = YES = YES
image ?

Edit Play Edit Play Lists

List °

Release Play Cancel edited Play Lists

List 3 > YES




\H

Item Operation/Description I Using p|ay List
Select Specify folders on microSD Card to save files to
storage * >YES Use Play List to organize Data Folder Ring Songs&Tones/
® Folders cannot be specified when saving Books files. Videos files.
Memory View memory capacity/number of saved files Select Ring Songs&Tones, Music or Videos folder files to
Status create Play List links to each file in its original folder.

Pictures/Videos folders only
Pictures folder only

1
2
3 Play List folder in Ring Songs&Tones folder onl - -
. mic);oSD Card only g-0n9 y Main Menu > Data Folder p> Ring Songs&Tones

> Music folder only 1 Highlight Play List — (3)[Menu] — Edit Play List

Creating Ring Songs&Tones Play Lists

2 Select a number = Select a folder = Select a file
® Repeat Step 2.

3 (=[Finish]

I Play Back Play List
>Main Menu b Data Folder p> Ring Songs&Tones »> Play List
® Files are played back in the saved order.

M Delete a File
> After Step 1, select a file = Release this

I Delete All Files
>In Step 1, ()[Menu] = Release Play List - YES

s3|14 buibeuepy | S

® mp4/3gp files cannot be added to Play List except in Music Player Play
List.
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Creating Video Play Lists

Main Menu p- Data Folder p> Videos »> Play List
1 Select a Play List

2 Select a number = Select a folder = Select a file
® Repeat Step 2.

3 (&)[Finish]

I Play Back Play Lists
>Main Menu p- Data Folder p> Videos b Play List b Highlight a
Play List = (=)[Play]

@ Files are played back in the saved order.

M Delete a File
> After Step 1, (highlight a file =) ()[Menu] - Delete this or
DEL all from list - YES

M Change Order
> After Step 1, ([Menu] = Oder to play = Select a file = Select a
target = (=)[Finish] = (=)[Finish]

10-16
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microSD Card

® 940P is compatible with up to 2 GB commercial microSD Cards and up
to 16 GB commercial microSDHC Cards (as of May 2009).
For information on memory card compatibility, visit the website
below (Japanese). Note that microSD Cards not listed on the website
may not function properly.
- From Yahoo! Keitai
P-eqgg (as of October 2009)
Main Menu p> Yahoo! p> Bookmarks
p> Panasonic top page (P-egg)
- From PC
http://panasonic.jp/mobile/
Not all operations are guaranteed by the microSD/microSDHC Cards
listed.
® Format new microSD/microSDHC Cards for use with 940P (c%P.9-18).

® SoftBank is not liable for damages from accidental loss/alteration of
microSD Card information. Keep a copy of Phone Book entries, etc. in a
separate place.

@ microSD Card has no write protect feature; there is a risk of accidental
erasure/overwriting of files.




I microSD Card Installation

® Turn off handset before inserting/removing microSD Card.
@ Battery Installation: £%P.1-13

Inserting

1 Insert microSD Card until it clicks

microSD Card Check

When microSD Card is installed correctly, B appears. If E,"i appears,
microSD Card cannot be used. Remove microSD Card from handset, and
re-insert it. If 3} does not disappear, execute Check microSD (£%P.9-21)
or format microSD Card (£%P.9-18).

(Display Indicator: £%P.1-10)

\H

Removing

1 Push microSD Card in
® microSD Card pops out with a light push.

® Do not turn off handset or remove battery/microSD Card while E3
flashes. microSD Card may be damaged or files lost.
® microSD Card may pop out when inserting/removing it.

s3|14 buibeuepy | S
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I Format microSD Card

® Formatting microSD Card deletes all saved files/data.
Main Menu p> Tools » microSD Backup
1 Menu] - microsD format

2 Enter Phone Password = YES

1 Select a category

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® microSD Cards formatted on other devices may not be used. Format
microSD Card on 940P before use.

® 940P cannot format incompatible microSD Cards.

® |f format fails, turn power off and remove microSD Card from 940P.
Reinsert microSD Card and format it again.

3 Select a data ‘

IViewing microSD Card Files

View Phone Book entries, Calendar events, Tasks, mail
messages, Notepads and Bookmarks backed up on microSD
Card.

Main Menu p> Tools » microSD Backup

10-18

[1[Phone Book |
ECalendar
gTasks

Incomé i
HSent me
ElUnsent Messages
Horafts
EIMemo Pad
EBookmarks

Category List

G microSD Backup

=090 <2
Il

File List

Backup date appears as file name.

2 Select a file ‘

09060600
Il

Data List

Aoki Taro

Aoki Ta.srB

,?L

2EAoki Taro

] 090XXXXXXXX
Detailed Data

® [f messages on microSD Card do not appear correctly, copy messages to
handset (C%P.9-19) and execute Charset Conversion (C%P.13-22).

g=



I Handset Data Backup

Back up handset data (Phone Book, Calendar, Tasks, Messages,
Notepad, Bookmarks, Content Keys) to microSD Card; restore
handset data after accidental loss/alteration.

@ Back up Content Key: £%P.9-22

Backing up to microSD Card
Main Menu p> Tools » microSD Backup

1 Highlight a category - (37)[Menu] -
Copy to microSD (= For Bookmarks, select an
item)

2 Enter Phone Password = VES
All files of selected category are backed up to microSD Card.

[ One File Backup
> Open a file = (x)[Menu] - Copy to microSD — YES

Restoring from microSD Card
Main Menu p> Tools »> microSD Backup
1 Selecta category

Restore One Item
Select a file = Highlight an item = (¥7)[Menu] =
Add to phone

Restore One File
Highlight a file & (7)[Menu] = Add to phone or
Overwrite to phone = Enter Phone Password

Restore All Files
(x7)[Menu] = Add all to phone or
Overwr. all to ph. = Enter Phone Password

3 YES 10
=
s
® Note that Overwrite to phone or Overwr. all to ph. erases all files S
of same category on handset. é
® Files of 10 MB or larger cannot be moved/copied from microSD Card to -
handset. 3
® Data backed up in other SoftBank handsets may not be restored in v
940P depending on type and size.
P ececcccccccccccccccccoe
@Delete Items from microSD Card @View microSD Card Memory Capacity
(©P.9-21)
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I PC File Transfers

Folder Structure

Files moved or copied from 940P to microSD Card are

managed as shown below:
® Save files in folders by file type.

Games and More

S! Appli

Music

Sound files with .3gp, .mp4, .smc

Other Documents

Other files

Pictograms My Pictograms
Still images moved/copied from
Pictures handset to Main Folder in microSD

Card

Sounds & Ringtones

Sound files of:

up to 10 MB with .3gp, .mp4,
up to 300 KB with .mid, .midi,
.amr

Videos moved/copied from

Videos handset to Main Folder in microSD
Card
Widget Widget contents
. PC Movies saved from PC to
WhiFile microSD Card
SD_VIDEO

@ V/ideos saved to microSD Card

DCIM
® Still images saved to microSD Card
PRIVATE
MYFOLDER
Utility
10 Calendar Calendar.BCK Calendar Backup files
§ Contacts Contacts.BCK Phone Book Backup files
3 Rights Content Key Backup files
%- Tasks Tasks.BCK Tasks Backup files
": Memo Memo.BCK Notepad Backup files
o Mail
e Drafts Drafts.BCK Drafts Backup files
Inbox Inbox.BCK Incoming Mail Backup files
Outbox Outbox.BCK Unsent Messages Backup files
iﬂe:;[sages ;eCnKt Messages. Sent Messages Backup files
My Items
Book E-comics
Bookmarks ‘ Bookmarks.BCK | Bookmarks Backup files
Flash(R) Flash® files
10-20

® Some copy protected files have extensions different from above.
® When moving/copying videos from microSD Card to handset, file format

or file size may change.

* If WMFile does not appear in My Items (MYFOLDER), create and save a

folder titled WMFile.




Using Data on microSD Card

With a microSD Card inserted, connect handset with a PC

via USB cable (not included) to read/write data from/onto

microSD Card.

Following equipment is required:

@ Connector Cable: USB cable

® PC: PC with USB port (Universal Serial Bus Specification Rev 1.1
compliant)

® Compatible Operating Systems: Windows® XP, Windows Vista® (Japanese
version in each)

Main Menu p> Settings p> Connectivity > USB Mode
» microSD Mode
1 Connect handset to PC via USB cable while 940P is on

® PC recognizes microSD Card.
® B appears in Standby (handset).

® Even if incoming call arrives, reading/writing data continues during
calls. After calls, check indicators on PC to see if reading/writing is
complete.

® File names saved in microSD Card may not properly appear if changed
on PC.

\H

I microSD Card Functions

M Restore microSD Card items (Check microSD)

Use Check microSD to repair microSD Card data errors.

> Main Menu > Tools »> microSD Backup »> (7)[Menu]
» Check microSD p- YES

® Do not turn handset power off or remove microSD Card or battery while
formatting; may damage handset or microSD Card.

® |t may take 30 seconds or longer to complete Check microSD depending
on data volume on microSD Card.

® 940P cannot check incompatible or unformatted microSD Cards.

® 940P may delete files and folders that fail to be restored.

I Delete Items from microSD Card

> Main Menu p> Tools » microSD Backup P> Select a category
> (Highlight a file =) (3)[Menu] p> Delete this or Delete all (> For
Delete all, enter Phone Password) » YES

@ Content Key cannot be deleted.

I View microSD Card Memory Capacity
> Main Menu p> Tools »> microSD Backup »> (7)[Menu]
» microSD info

s3|14 buibeuepy | S
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I Back Up Content key

Copy Content Keys to microSD Card from handset or to handset from

microSD Card.

>Main Menu p> Settings p> Security p> Content Key
» Copy to microSD or Copy from microSD p> Enter Phone
Password

@ Content Keys with expiration dates or usage limits cannot be backed up.

® USIM Card inserted when Content Keys were moved to microSD Card
must be inserted to move Content Keys from microSD Card.

® Some applications are made for use on specific models. Some models
move Content Keys to microSD Card instead of backing up. Contact
SoftBank Mobile Customer Center, General Information for more
information(C%P.19-34).

sa|14 buibeuepy | S
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Infrared
Before Using Infrare
One/Multiple File Transfer
All File Transfers
IC Transmission
One File Transfer.
All File Transfers..
Bluetooth®
Before Using Bluetoot
Using Bluetootl
Suspending Bluetooth® Functions ..

Placing Bluetooth® Devices on Standby for Connectio
Sending/Receiving Phone Book
Bluetooth® Functions

SoftBank Utility Software (Japanese).
USB (Japanese) ..

Setting USB Mode ..

Transferring Data via USB Cable

Data Communication via USB Cable
AV Output

Connecting Handset to TV
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Infrared
I Before Using Infrared

Transfer Phone Book/Calendar events, messages, bookmarks

and Data Folder files wirelessly between 940P and

compatible devices, including PCs and other mobiles.

® 940P infrared function is based on IrMC1.1, however, some IrMC1.1-
based device transmissions may not be transmitted/received within
specification.

® Debris may inhibit infrared transfers; clean infrared ports with a soft cloth
beforehand.

@ Direct sunlight/fluorescent light may inhibit transfers.

® Align infrared ports within 20 cm of one another and make sure no
objects are placed between them. Do not move the devices until transfer
is complete.

Within 20 cm

Infrared Port

Transferable Files

Condition . .
Transferable file il ALk
Phone Book (Account Details) O Up to 1000
Calendar events ' O Up to 1000
Tasks O Up to 100
Received message O Up to 3000
Sent message O Up to 1000
Drafts O Upto 10
Notepad O Up to 20
Ring Songs&Tones O —
Still image 23 O —
Video 3 O —
Bookmark
(Yahoo! Keitai, PC Site Browser) o Up 0 100 each
Widget * O —

O: Transferable —: Not transferable

! Saved Holidays/Memorial days not transferable
2 Including Flash® files

3 Multiple files transferable

® Following files cannot transfer:
- Files prohibited for transfers from 940P
- Phone Book entries and SMS on USIM Card
® |f memory becomes full, remaining entries are truncated (Memory List:
%P.19-25).
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I One/Multiple File Transfer
@ Transferable Files: £%P.10-2

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (w/[Menu] = Send Ir data - Send phonebook

Account > @[]
Details

Messages > (x7)[Menu] - Send Ir data — Send This

Bookmarks > (x/[Menu] = Send to ExtrnlDvcs — Send Ir data

- Send This

Still Images/ > (x7)[Menu] - Send Ir data

Videos/ ® To send multiple files: (3)[Menu] -

Widgets Multiple-choice — Select files to send = (x7)[Menu]
- Send Ir data

Other Files > (¥/[Menu] - Send Ir data

) YES
Receiving

Main Menu p> Tools p> Receive via Infrared p> Receive

When a file is received, YES

Send files from sender side within 30 seconds.
® To receive subsequent files, select YES.

I All File Transfers

Precaution

® Receiving all files overwrites all saved files including secret/protected
files.

@ Sending all Phone Book entries sends Account Details as well.
User-edited information is overwritten (handset number remains).

Session Number

Session number (4 digits) is required for all file transfers via Infrared and
IC transmission. Sender and recipient must enter same Session number to
complete transfers.

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book  (x7)[Menu] - Send Ir data - Send all phonebook

Messages (x)[Menu] - Send Ir data - Send All

Bookmarks  (x7)[Menu] - Send to ExtrnIDvcs - Send Ir data
- Send All

Other Files  (¥/)[Menu] - Send all Ir data

2 Enter Phone Password = Enter Session number = YES
Recipient must enter the same Session number to start transfers.

I E
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Receiving
Main Menu p> Tools p> Receive via Infrared »> Receive All

Enter Phone Password = Enter same Session number
as sender's = YES — YES

Saved files are deleted, and transfer starts.

11-4

\H

IC Transmission

Exchange files with another IC compatible handset using

reader/writer function.

® Type of files and transfer conditions are same as those for infrared file
transfer (C%P.10-2).
Multiple file transfer is not available.

® |C transmission is not available when /C Card Lock (C¥P.16-5) is
activated.

® \When receiving dada, end all active functions.

@ [f there is difficulty in file transfer, move a 5 ) logo close to or away from
the other logo or move each side up, down, left, or right.

® Data cannot be sent during charging battery.

Align 5 logos of both handsets

B
N

=
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I One File Transfer

Before Receiving a File

® Receive IC Datum is set to ON by default. When
Receive IC Datum is OFF, One File Transfer is unavailable.

® To set Receive IC Datum on:

Main Menu p> Tools or S! Appli p> Osaifu-Keitai

P> IC Card Settings P> Receive IC Datum p> ON

Sending
1 Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (x7)[Menu] = IC transmission - Send phonebook
Account > (@)[ICtrans]

Details

Messages > (x7)[Menu] = IC Transmission = Send This

Bookmarks > (3)[Menu] = Send to ExtrnlDvcs -
IC transmission = Send This

Other Files > (3)[Menu] - IC transmission

J YES
Receiving

1 Align 2] logo on sender side with 940P (recipient) =
YES

I All File Transfers

® Precautions/Session number (€%P.10-3)

Sending

1

Highlight a file, and follow the steps below

Files to Send Operation/Description

Phone Book > (x7)[Menu] - IC transmission —

Send all phonebook

Messages > (x7)[Menu] - IC Transmission - Send All

Bookmarks > (x/)[Menu] - Send to ExtrnIDvcs -

IC transmission - Send All

Other Files > (x)[Menu] - A/lIC transmission

2 Enter Phone Password = Enter Session number = YES

Recipient must enter the same Session number to start transfers.

Receiving

1
2

Align %) logo on sender side with 940P (recipient)

YES — Enter Phone Password = Enter same Session
number as sender's
Saved files are deleted. Transfer starts.
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Bluetooth®

Connect handset to Bluetooth® devices to use functions

\H

below.
Function Device Description
Handsfree Calls Headsets
(©P.10-10) Handsfree devices Talk handsfree on handset

Wireless Playback

Audio devices

Play back sounds (Digital TV/
Video) or music (Music Player)

I Before Using Bluetooth®

Bluetooth® Specifications

Version

Bluetooth® specification Ver.2.0+EDR

Supported Profiles '

HSP (Headset Profile)

HFP (Hands-Free Profile)

A2DP: Advanced Audio Distribution
Profile

E 0
o
=
=
]
N
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P ececcccccccccsccccccccoce

@ITTD @Stop Ringtone Output to Headset/Handsfree Device
@Continue Calls on Handset when Bluetooth® is Disconnected

from Headset/Handsfree Device @Always Make Calls from 940P
even when Headset is Connected @Always Use Handsfree Device

to Make/Receive Calls (c%P.18-17)

11-6

(C¥P.10-10) wirelessly from external AVRCP: Audio Video Remote Control
speaker Profile

Internet Connect wirelessly to Internet DUNP: Dial-up Networking Profile

Connection PC using handset as external OPP (Object Push Profile)

(C*¥P.10-10) modem Output Bluetooth® Power Class2

Sending/Receiving pC Send/receive Phone Book Frequenc'y Ba'mds Z. 2.4GHz.(2.4026Hz—2.4806Hz)

Z;:PnfOBQ(;Ok Handsets entries wirelessly Communication Distance > | Approximately ten meters

! Bluetooth® connections are available with compatible devices supporting

the same profile.

2 Bluetooth® operates in the 2.4 GHz unlicensed frequency band.Depending
on other devices in use in the spectrum, Bluetooth® connection may slow
down/terminate, or range may decrease.

3 Affected by distance between devices, obstructions, signal conditions,

handset status, etc.



Notes

® 940P may not be able to establish a Bluetooth® connection with some
Bluetooth® devices.

@ Establish connections with certified Bluetooth® devices that meet the
specification standards developed by Bluetooth® SIG.

® Due to the unique characteristics/specifications of a certified Bluetooth®
device, connections or transfers may fail; procedures, displayed results or
operations may vary from those described in the manual.

® When data transfer is interrupted, it may take some time for process to
complete.

® Noise may interfere with wireless or handsfree conversations depending
on the status of connected devices or signal conditions.

@ For details about headset/handsfree devices, see the device manuals.

\H

I Using Bluetooth®

Pair Bluetooth® devices with 940P beforehand to establish
connections for different Bluetooth® functions.

Searching & Pairing Devices

Search other Bluetooth® devices.

Paired devices appear in Search&Paired Device list.

@ Bluetooth® Passkey is not necessary for paired devices.

® Search up to 20 Bluetooth® devices at one time; pair with up to ten
Bluetooth® devices.

® Place Bluetooth® devices on standby for connection.

Main Menu p> Tools p> Bluetooth p> Search&Paired Device
1 YES*

Device search starts and names of found devices appear.

® To search again: (&)[Search]

*If there are already paired devices in list, select a device = Select a
function

2 Select a device = YES = Enter Phone Password

Select text entry field = Enter Bluetooth® Passkey

w

4 Select a Bluetooth® function

/ __ Next Page 4
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940P connects to Bluetooth® device. When complete, § flashes in
blue. After no Bluetooth® connection is made for a certain time,
€ appears in black and Power saver mode starts.

® When Bluetooth® device can connect to multiple services,

confirmation appears asking whether to connect to another service.

® While connected, [%|(Blue) appears. While in Standby, [ (Gray)
appears.

® When Dial-up is selected, 940P stands by for connection requests
from other Bluetooth® devices.

® Dijal-up can be selected regardless of profile types.

Bluetooth® Passkey

Bluetooth® Passkey (1 to 16 digits) is required to connect

Bluetooth® devices; sender and recipient must input the same code to
complete file transfers.

@ Bluetooth® Passkey is not necessary for paired devices.

M Search&Paired Device List
@ Device Type
Indicators appear for different
types of devices.
@ Device Name
Device names appear.
When no names are found,
Bluetooth® addresses appear.
@ Connection Status
[@]: Connected [O]: Not connected [X]: Not found [&]: Not paired

[ Search&Paired Dev.

P16 CPC
[@®] DuNHFP HSFIFIRoPP
Search&Paired Device

\H

O Protection

Indicator appears when registered contents are protected.
@ Profile Status

Indicators appear to show profile status.

Icon | Letter Color |Background Color | Frame Color Status

Blue Gray - Not connected (Not paired)
Blue Gray Blue | Not connected (Paired)
EEd | White Green - Connected

Green White Green | Standby for connection
HSP White | Light green - Preferred device

Gray Gray - Not supported

PP eceeccccccccccccccccccoe
ETTTD @Set Duration to Search for Bluetooth® Devices ((%P.18-17)

=
S

I Suspending Bluetooth® Functions

Suspend all Bluetooth® functions connected or on standby
for connection, and disable Bluetooth®.

Main Menu p> Tools p> Bluetooth

1 Bluetooth OFF - YES

® To return to standby for previously connected function:
Bluetooth ON



Placing Bluetooth® Devices on Standby for
Connection

Main Menu p> Tools p> Bluetooth »> Accept Registered

Check functions to be on standby for connection =

(&)[Finish]

® To uncheck, select functions to remove check marks.

I Sending/Receiving Phone Book

Sending
1 Open Phone Book - (x7)[Menu] -
Send to Bluetooth

2 One File Transfer
Send phonebook — Select a recipient device

All File Transfer
Send all phonebook — Select a recipient device =
Enter Phone Password

3 YES

\H

Receiving

Main Menu p> Tools p> Bluetooth > Receive via Bluetooth

One File Transfer
Receive - YES

All File Transfer
Receive All = Enter Phone Password = YES — YES

® [f memory becomes full, remaining entries are truncated (Memory
List: %P.19-25).

JPeececcccccccccccccccccoe
(ITTD @Set Authentication/Encryption to Send Phone Book Entries

@Etnter Password when Sending All Phone Book Entries
([C%P.18-17)



I Bluetooth® Functions
(From p Main Menu p> Tools b Bluetooth

M Functions Available in Search&Paired Device Window
> Search&Paired Device - (x7)[Menu] = Select an item (See below)

Item Operation/Description
Register > Enter Phone Password = Pair devices
devices (%From Step 3 on P.10-7)
Preferred Set a preferred Bluetooth® device for incoming calls
device ® Available only for headset function compatible

Bluetooth® devices.
® To cancel, perform same operation.

Protect/ Protect/cancel devices. Protection prevents devices from
release being deleted or overwritten
Change > Enter a device name
device name
Delete >YES

Description  Show device name, Bluetooth® address, device class and

supported profile

Add shortcut Create shortcuts (C%P.1-22)
icon

I Make/Receive Calls via Bluetooth®
> Search&Paired Device = Select a device & Headset or Hands-free
— YES = Make/receive a call using Bluetooth® device

11-10
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I Use Bluetooth® Device for Wireless Playback

> Search&Paired Device — Select a device = Audio = Watch Digital
TV or play back videos or music

® Digital TV/Video sounds are played only by A2DP profile compatible
Bluetooth® devices compliant with SCMS-T copyright protection
standard.

I Connect to Internet Using Bluetooth® Device

> Search&Paired Device — Select a device = Dial-up

® 940P waits for dial-up connection.

@ Refer to a manual for Bluetooth® device for details.
Download utility software (940P) "Modem Wizard" from website below
to PC and install software.
http://panasonic.jp/mobile/support/download/940p/index.html

® To establish a dial-up connection, see Help on "Modem Wizard."

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission charges.

I Place Bluetooth® Device on Standby for Dial-up
> Dialup Rgstry Standby — Enter Phone Password = YES = Select
Bluetooth® Passkey text box = Enter Bluetooth® Passkey
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SoftBank Utility Software (Japanese)

Phone Book, Calendar, Tasks, messages, Bookmarks,

Notepads and Data Folder can be transferred to a PC, edited

or managed by using SoftBank Utility Software.

@ For details on and downloading SoftBank Utility Software, visit
http://www.softbank.jp/mb/r/sbu/ (Japanese)

® USB cable (not included) is necessary for using SoftBank Utility
Software.

® S! Appli, PC Movies, TV, Lifestyle-Appli, Books, Customized Screen,
Templates and Other Documents cannot be backed up.

® Copy protected files may not be backed up.

® Set USB Mode to Communication Mode ([CFRight).

USB (Japanese)

Connect 940P to a PC via USB cable (not included) specified
by SoftBank for data transfer or data communication.

I Setting USB Mode

<Default> Communication Mode

Main Menu p- Settings P> Connectivity > USB Mode

1 Select an item (See below)

Item Operation/Description

Communication Packet transmission, 64K data transmission, data transfer

Mode and calls with USB handsfree compatible devices are
available (% Left)

microSD Read/write data on microSD Card (C%P.9-21)

Mode

MTP Mode  Transfer/delete music data via Windows Media® Player on

PC (%P.8-4)

ITransferring Data via USB Cable

@ Transfer data using SoftBank Utility Software (C%Left).
® Transferring data in microSD Mode (C%P.9-21)

I E
=)
=]
=]
"]
N
=.
<
=3
<

11-11



Data Communication via USB Cable

Use 940P as a modem for Internet access by connecting
940P with a PC.

1
2
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Download utility software from URL below and install on PC.

http://panasonic.jp/mabile/support/download/940p/index.html
Install "USB N =~/ \ (USB Driver)" and "Modem
Wizard" from Utility Software (940P) to a PC

Set 940P to Communication Mode (Z#P.10-11), and
connect 940P to PC via USB cable

® Power up 940P before connecting to PC via USB cable.

Start up "Modem Wizard", and operate communication
setup

® "Modem Wizard" enables you to set up APN and dial-up easily.
For setup/starting procedures, see "Modem Wizard" Help.

® Connecting handset to a PC or PDA for Internet access may incur high
packet transmission fees.




AV Output

View the following on a TV set or other devices using a
SoftBank-specified video output cable (not included): Video
Call images, Digital TV images, still images/videos saved on
940P.

® View AV-output-compatible S! Appli on TV.

I Connecting Handset to TV

® To use video output cable (not included), Stereo Earphone Conversion
Cable (not included) is required.

Video @Qw < A0 mme

Audio L © ===
Audio R © €= <

External Port

1 Open External Port Cover

2 Connect video output cable to handset using
conversion cable
@ To connect video output cable to conversion cable: £%P.1-4

3 Connect video output cable to video/audio input
terminal on TV set

4 Open an image file on 940P
® To toggle display size:

® Some images cannot be displayed on TV.
® Display size setting is not available for some TV sets.

11-13
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Changing Phone Password
Security Functions
USIM PINs...

Personal Data Lock.

Activating Personal Data Lock w

Secure Remote Lock

Key Pad Dial Lock ...

Additional Lock Function
Restricting Calls/Messages..

Hiding Call Logs and Sent/Received Address List
Secret Mode/Secret Data Only

Setting Secret Mail .

Mail Security

Call Restrictions

Delaying Ringtone ..

Rejecting Unknown Callers

Rejecting Calls without Caller ID

Reset Settings
All Reset
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Changing Phone Password
<Default> 9999

Change Phone Password as required.
® For Phone Password details: £%P.1-28

Main Menu p- Settings > Security p> Change Phone Password
1 Enter current 4-8-digit Phone Password

2 Enter new 4-8-digit Phone Password = YES

Security Functions
| usim PINs

@ For more information about PINs: £%P.1-3

® Emergency numbers (110, 119, 118) are not dialable in PIN/PIN2,
PUK/PUK2 entry window.

PIN Authentication

Activate to require PIN entry each time handset is turned
on.

Main Menu p- Settings P> Security »> PIN Authentication

1 Enter Phone Password = PIN Authentication
2 ON or OFF
3 Enter PIN



Changing PIN/PIN2
® Set PIN Authentication to ON before changing PIN (C¥Above).
Main Menu p- Settings P> Security »> PIN Authentication

Enter Phone Password = Change PIN or
Change PIN2

2 Enter current PIN/PIN2
3 Enter new PIN/PIN2
4 Reenter new PIN/PIN2

\H

PIN Lock & Cancellation (PUK/PUK2)

PIN Lock or PIN2 Lock is activated if PIN or PIN2 is

incorrectly entered three times. Cancel PIN Lock or PIN2

Lock by entering PIN Unblocking Key (PUK/PUK2).

@ For information about PUK/PUK2, contact SoftBank Mobile Customer
Center, General Information (C%P.19-34).

1 In PIN lock mode, enter PUK/PUK2
2 Enter new PIN/PIN2
3 Reenter new PIN/PIN2

® |f PUK/PUK2 is incorrectly entered ten times, USIM Card is locked and
handset is disabled (Even turning off power is counted as one incorrect
entry.). Write down PUK/PUK2.

® For procedures required to unlock USIM Card, contact SoftBank Mobile
Customer Center, General Information (C%P.19-34).

-
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I Keyguard

Lock handset keys to prevent accidental operation except

when turning power on/off or answering incoming calls.

® While set, @& appears in Standby.

® By default, Keyguard temporarily cancels when handset opens (Keyguard
Setting: L& Right).

® Activate Keyguard in specified time after closing handset (Timer Lock at
Close: %P.12-7)

1 InStandby, press and hold (®

® To toggle Keyguard settings, repeat operation.

While Keyguard is Active

® Emergency numbers (110, 119, 118) are dialable even when Keyguard
is set to Lock Even Slide Open. Entered numbers do not appear on
Display. Once numbers are dialed, Keyguard is canceled.

® Press (=) to disable Calendar event tone or Alarm.

@ Keyguard can be canceled even during a call.

® Alternatively, Main Menu P> Settings P> Security Settings
» Keyguard p> ON or OFF to activate/deactivate Keyguard
® Turning off power cannot cancel Keyguard.

Keyguard Setting

<Default> Unlock When Slide Open

Activate to cancel Keyguard temporarily when opening
handset.

Main Menu p> Settings P> Security Settings
» Keyguard Setting

Lock Even Slide Open or
Unlock When Slide Open
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I Privacy Key Lock

<Default> OFF

Set Privacy Key Lock to require Phone Password for using
940P except for turning handset on/off and answering calls.
@ While locked, fi appears in Standby.

Main Menu b Settings > Security »> Privacy Key Lock

Enter Phone Password

® To cancel Privacy Key Lock, enter Phone Password in Standby. If
Phone Password is incorrectly entered five times, 940P turns off.

While Privacy Key Lock is Active

® Emergency numbers (110, 119, 118) are dialable even when Privacy
Key Lock is active.

® Only phone numbers appear on Display for incoming calls.

@ Calls cannot be received by Bluetooth® headsets or handsfree devices.

® Message ringtones or Alarm tones are disabled.

@ Calendar event tone or Alarm is disabled.

® S! Quick News and some indicators do not appear. They appear after
Privacy Key Lock is canceled.

I Personal Data Lock

Set Personal Data Lock to prevent others from reading or
tampering with your personal information in Phone Book or
Data Folder. Activate to require Phone Password for
accessing personal data.

M Locked Functions/Data

@ Turning off power cannot cancel Privacy Key Lock.

- Messaging

- SI Appli

- Phone Book search/saving/setting
- Memory Manager/ Memory Status

(Phone Book)

- Account Details
- Restrictions (Phone Book)

- Voice Announce
- Post blog

* Font setting is available.

- Yahoo! Keitai viewing/setting

- PC Site Browser viewing/setting
- Bookmarks/ Saved Pages

- BookSurfing®/e-Book Viewer

- Mobile Widget

- SI Quick News

- SI Information Channel/Weather

- Notepad - Content Key obtaining/backup
- Calendar - Voice Dial

- Tasks - SI.GPS Navi

- Shortcuts - Data Folder*

- Event Indicators - Music Player

- Camera/Video Camera - Digital TV

- Album-Touch - Bar Code Reader

- Lifestyle Appli - Receive via Infrared/Bluetooth®
- microSD Backup - IC Data transmission

- Answer Phone - Alarm

- Voice Recorder - Dictionary

- Customized Screen - Pedometer

- Reset Settings/All Reset
- Software Update

-
N
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Activating/Canceling Personal Data Lock

<Default> Deactivate

@ \While locked, g appears in Standby.
Main Menu p> Settings P> Security > Personal Data Lock

1 Enter Phone Password = Activate/Deactivate

® To cancel Personal Data Lock, repeat operation. If Timer Lock at
Close is set, password entry is requested when 940P is opened.

Canceling Personal Data Lock Temporarily

When Phone Password is entered, g disappears and disabled functions

become temporarily available.

@ Once handset returns to Standby while no functions are active,
Personal Data Lock is active again.

@ Some functions remain unavailable. Deactivate Personal Data Lock to
use the following:
- Receiving IC data - Reject unknown

Enter Phone Password = Customize — Select an
item (See below)

Item Operation/Description
Alarm Tone  Enable/disable Alarms (Calendar, TV timer, or other alerts)
or TV Timer Recording.
> Select an item = Accept (Enable) or Not Accept
(Disable)

Incoming Call Show/hide Event Indicator (incoming messages) or Phone
Act Book entry information (incoming calls).
> Select an item
- Incoming Message - Accept (Show indicator) or
Not Accept (Hide indicator)
- Phone Book Available = Accept (Show Phone
Book Entry information) or Not Accept (Hide
information)

® While Personal Data Lock is set, some indicators do not appear in
Standby. They appear after lock is canceled.
@ Turning off power does not cancel Personal Data Lock.

Customizing Personal Data Lock

Enable/disable Alarm, incoming message notification, etc.
while Personal Data Lock is active.

Main Menu p> Settings »> Security »> Personal Data Lock

Display/Tone Enable/disable Display settings, ringtones or indicators.
> Select an item

- Internal Display = Accept (Enable Display
Settings) or Mot Accept (Disable)

- Ring Tones = Accept (Enable Sound Settings) or
Not Accept (Disable)

- §! Quick News — Accept (Show information) or
Not Accept (Hide information)

- S! Info Ch./Weather - Accept (Show indicators)
or Not Accept (Hide indicators)

- Widget Contents = Accept (Show widgets) or
Not Accept (Hide widgets)
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Showing Personal Data Lock OFF Window when
Opening Handset

<Default> OFF
Main Menu p> Settings P> Security p> Lock OFF at Open

1 Enter Phone Password

2 Personal Data Lock - ON

® When Timer Lock at Close and Lock OFF at Open are both active,
canceling Personal Data Lock when opening handset temporarily
cancels lock. However, lock activates again when specified time elapses
after closing 940P.

Activating Personal Data Lock when Closing
Handset

<Default> Keyguard: OFF
Personal Data Lock: OFF

Set Timer Lock at Close to automatically activate Keyguard
or Personal Data Lock when specified time has elapsed after
940P is closed.

® While locked, g appears in Standby.

Main Menu b Settings »> Security p> Timer Lock at Close

1 Enter Phone Password

2 Keyguard or Personal Data Lock — Select a time

When Personal Data Lock is selected, confirmation
® When OFF is selected, setting is canceled.

-
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I Secure Remote Lock

If handset is lost or stolen, remotely lock handset from a PC

or mobile. If Secure Remote Lock is active, all operations are

unavailable except to turn handset on.

® For service details and user agreement/registration, visit SOFTBANK
MOBILE Corp. Website (http://www.softbank.jp) or My SoftBank.

Accessing My SoftBank from Handset (Japanese)

For service details, visit SOFTBANK MOBILE Corp. Website.

Main Menu p> Yahoo! > X=a2—UX k p» My SoftBank
p English

® Follow onscreen instructions.

® Emergency numbers (110, 119, 118) are dialable even while Secure
Remote Lock is set.

Showing Messages during Secure Remote Lock

<Default> OFF

Set Display message to appear when Secure Remote Lock is
active.
® Use preset message or Create a message.

Main Menu b Settings »> Security > Lock Message

1 Enter Phone Password
7 Display Setting - ON

Il Save Lock Messages
> After Step 1, Message — Enter a message
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I Key Pad Dial Lock

<Default> Deactivate

Allow dialing only from Phone Book entries and lock dialing
with keypad. Unauthorized use of 940P can be prevented.
® While locked, & ¢ appears in Standby.

I Unavailable Operations
- Dialing with keypad

- Phone Book (saving, editing, deleting, copying from microSD Card, and
sending/receiving via Infrared, IC transmission and Bluetooth®)

- Sending S! Mail (by typing in address)/SMS

I Available Operations
- Dialing from Phone Book or Voice Dial

- Dialing from Redial, Outgoing Call Logs, Incoming Call Logs, Sent
address, or Received address (only phone numbers/mail addresses saved
in Phone Book)

Main Menu p> Settings P> Security p> Key Pad Dial Lock

Enter Phone Password

While Key Pad Dial Lock is set, g appears in Standby.
® To cancel Key Pad Dial Lock, repeat operation.

® Emergency numbers (110, 119, 118) are dialable even while Key Pad
Dial Lock is set.

IAdditionaI Lock Functions

M IC Card Lock
Deactivate Osaifu-Keitai® functions (£%P.16-5).

M Remote Lock

Deactivate Osaifu-Keitai® functions remotely (C%P.16-5).

-
N
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Restricting Calls/Messages
I Hiding Call Logs and Sent/Received Address List

<Default> ON
Main Menu b Settings »> Incoming Settings p> Call Logs

1 Enter Phone Password

2 Select an item (See below)

Item Operation/Description
Incoming Show/hide Incoming Call Logs/Received address list
Outgoing Show/hide Redial/Outgoing Call Logs/Sent address list
12 3 OFF
==
o
=
§ ® While Incoming Call Logs is OFF, Answer Phone (Voice Calls) does not
; play. Selecting Missed Call indicator does not show Incoming Call Logs.
2
c
=.
~
<
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I Secret Mode/Secret Data Only

<Default> Deactivate

Phone Book entries and calendar events saved as secret

data appear only when 940P is in Secret Mode/Secret Data

Only.

® Set Phone Book or Calendar events as secret data (Phone Book: c¥P.4-7,
4-8 / Calendar events: £%P.12-5)

Main Menu p> Settings p> Security

1 Select an item (See below)

Item Operation/Description

Secret Mode View all data including secret data
@ \While set, g appears in Standby.

Secret Data
Only

View only secret data
@ While set, g flashes in Standby.

Enter Phone Password
For Secret Data Only, number of saved secret data appears.

I Cancel Secret Mode/Secret Data Only

> In Standby, (= or follow Step 1 above

° gdisappears.

® \When widgets are shown, (=) to hide and press (=) again.
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I Cancel Secret Mode/Secret Setting
> In Phone Book/Calendar event window, (x7)[Menu] - Release secret

® Select whether to save data edited/saved in Secret Mode as secret data.
Data saved/edited in Secret Data Only are saved as secret data.
® Turn off handset to cancel secret setting.

PP eecccccccccccccccoccccoe
@ITTD @Set Learning Feature Off for Secret Mode/Secret Data Only
(*P.18-10)

I Setting Secret Mail
<Default> ON

Forbid showing messages from secret Phone Book entries.
® Secret mail can be viewed in Secret Mode/Secret Data Only even when
Secret Mail Display is set to OFF.

1 - Settings

) Universal Settings - Secret Mail Display
3 Enter Phone Password
/ OFF

® When both Spam Filter and Secret Mail Display are set, messages from
Phone Book entries saved as secret mode are sorted into Spam Folder

(Safe List: £%P.13-17).

-
N
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I Mail Security

Set handset to require Phone Password for opening mail
boxes or operating Server Mail.
@ 7] appears for set mail boxes and menus.

1 - Settings

2 Universal Settings - Mail Security
Enter Phone Password = Select items* — [Finish]
*To cancel: press (*) again.

I Set/Cancel Mail Security by Incoming Mail or Sent/Unsent
Folder
> (&2) = Incoming Mail or Sent/Unsent = Highlight a folder —

12 ()[Menu] - Mail Security = Enter Phone Password
- ® [ appears for set folders.
E
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I Call Restrictions

Reject/accept/forward calls from specified phone numbers,
or restrict calling unspecified phone numbers.

1 (2) = Search Phone Book
2 Selectan entry - (¥7)[Menu] - Restrictions
3 Enter Phone Password

4 Select an item (See below)

Item Operation/Description
Restrict Allow calls only to specified numbers
Dialing
Call Rejection Reject specified numbers
Call Accept from specified numbers only
Acceptance
Call Automatically forward specified numbers
Forwarding @ Set destination numbers (Call Forwarding: C%P.2-17)

® To cancel, repeat operation.

I View/Cancel Phone Book Restrictions

> Main Menu » Phone Book p> Restrictions P> Enter Phone Password
P> Select an item™ P> Select a Phone Book entry B> Select a number
> YES

*  appears for set item.

® Highlight an item, (x7[Menu] — Release Settings — YES to cancel
restriction on all specified numbers.
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® Missed call indicator appears in Standby for calls from rejected
numbers.

I Delaying Ringtone

<Default> OFF

Delay ringtone/vibration for Voice/Video Calls from unknown
numbers.

Main Menu p> Settings P> Incoming Settings
p> Ring Time Settings »> Ring Starting Time

1 ON — Enter start time

M Hide Missed Call Records (Disconnected during Ringtone
Delay)

>Main Menu P> Settings P> Incoming Settings
P Ring Time Settings > Missed Calls Display > Not Display

I Rejecting Unknown Callers

<Default> Accept
Main Menu p> Settings »> Security > Reject Unknown

1 Enter Phone Password - Reject

I Rejecting Calls without Caller ID
<Default> Accept
Reject calls without Caller ID or from pay phones.

Main Menu p- Settings »> Security p> Call Setting w/o ID

1 Enter Phone Password

2 Select an item = Reject

-
N
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Reset
I Reset Settings

Cancel custom settings and return handset functions to their
default settings.

Main Menu p> Settings P> Security > Reset Settings
1 Enter Phone Password = YES

® Some default settings may not be restored.
® Reset Settings cancels Navi Appli settings in S! GPS Navi. Set a
Navi Appli to activate from Select Navi Appli (C5P.18-22).

-
N
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I All Reset

Cancel custom settings and return handset functions to their
default settings; clear all Phone Book/Data Folder entries
etc.

Main Menu p> Settings P> Security - All Reset
Enter Phone Password = YES = YES

940P automatically turns off and restarts.

@ Fully charge battery ( [E]) beforehand.
® Phone Password is reset to default.
@ USIM Card/microSD Card files are not affected.
® Data transmission settings (set via PC) are not affected.
® Non-restorable items when deleted by All Reset:
- Customized settings, Call Logs, downloaded S! Appli, etc.
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Calendar

View by day, week or month; set Alarms for events.

I Opening Calendar

Main Menu p> Tools p> Calendar

I Creating Calendar Events
Save up to 1000 entries.
Main Menu p> Tools p> Calendar

@ to highlight a date =

O cheduled (No Tltle)

-
Current month appears. 2009/ 6/ 6Gat) .[NeW] Schedule ool day,
. . un Mon Tue Wed Thu Fri Sa 2009/ 5/ 6 10:10
® When a date with Calendar events is selected, 13 3 4 i @Date(T
number of AM and PM events and up to three 28 ol 10l 111 12| 13 2009/ 8/
CoRepeat OFF|
contents appear. 14 15| 16| 17/ 18 19 20 €7Alarm OFF
® ()[Prev.] or (ta)[Next] to show previous/ 12 2 27 RTone Clock Alarm Tone
[#Contents
next month calendar. 28] 29| 30
@ To switch Monthly/Weekly view: £3P.12-4 - 2 Select an item (See below)
2 E 1
W Item Operation/Description
1112:30 Nea Select icon/ > Select an icon = Edit subject
Dselects Edit summary
Monthly View Edit location > Enter location
Whole day > OFF or ON
setting ® When ON is set, Alarm goes off at 0:00 a.m.
Date (from) > Enter start date and time
Date (to) > Enter end date and time
Repeat > Select a repetition = (For Select day, check days
- (=)[Finish])
Alarm > Select an Alarm type (— For ON/Set time, enter time)
® Alarm Tone: C5P.12-6
Alarm tone > Select an Alarm tone type = Select a folder = Select
an Alarm tone
Contents > Enter event description

PR
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3 (=)[Finish]

Calendar Event Indicators

Following indicators appear in Calendar Window.

M (Blue): Morning event

M (Orange): Afternoon event

_ (Underscore): Event that lasts for two days or longer

® Following indicators appear on Display.

: Alarm @ : Monthly
I3 : Daily Yearly
- Weekly

® Calendar events between 00:00 on 2000/01/01 and 23:59 on
2037/12/31 can be saved on 940P.
® Alarm tone does not sound when Privacy Key Lock or Personal Data

Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.11-5).

\H

I Saving Holidays/Memorial Days

Save up to 100 entries (one entry a day) each for Holidays
or Memorial days.

Main Menu p> Tools p» Calendar

1 (Highlight a date —) (&)[New] = Holidays or
Memorial days

2 Select an item (See below)

Item Operation/Description

Date setting > Enter a date

Repeat > Select a repetition type

® 1 time does not repeat Holidays/Memorial days
events.

Edit holiday/ > Enter description
anniversary

3 (=[Finish]

Indicators
Holidays appear in red.
Memorial days are marked with a red circle.

® Following indicators appear in Calendar/Calendar Event List Window:
% : Holidays ~ /# : Memorial days : Yearly repeat

g
=2
w
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IViewing/Editing Calendar Event Details

Main Menu p> Tools p> Calendar
1 €39 to select a date

B 2009/ 6/ 6(Sat)
11:

12:3
fiMeal
Calendar Event List

Select an event

. Q Summary
Detailed schedule appears.  Scheduled
. . . . <4
® To edit: ()[Edit] = Edit selected item G;gggtle%fgg;)
(Schedule: C%From Step 2 on P.12-2/ 3009/ 11:35
Holiday, Anniversary: Z3From Step 2 on ®ng§/(t 530 11 35
- CORepeat
P12:3) EAlarm
[ZContents
Scheduled

Calendar Event Details

I Calendar Functions

(From Jp Main Menu b Tools p> Calendar

I Functions Available in Calendar Window
> Highlight a date = (x7)[Menu] = Select an item (See below)

Item Operation/Description

Weekly Toggle Monthly/Weekly view

display/

1 Month

Icon display  Entries in category of selected icon appear
> Select an icon

No. of Display number of saved Schedule, Holiday or Anniversary

schedules entries

Add shortcut Create a shortcut (C%¥P.1-22)

icon

Send all Ir (C¥P.10-3)

data

AlliC ([C%P.10-5)

transmission

Delete past  Delete past entries/items, prior to highlighted date
> Select a category to delete = YES

Delete all > Enter Phone Password = Select an item = YES

Reset Restore deleted Holidays

holidays > YES

M Functions Available in Calendar Events List/Details
> Select a date (= Select a Schedule, Holiday or Anniversary) =
(x)[Menu] - Select an item (See below)

Item Operation/Description

New Create a new entry (C%P.12-2, P.12-3)

Item Operation/Description
New Create a new entry (C3P.12-2, P.12-3)
Edit Edit selected item (% Left)
Copy Copy an entry to another day
> Enter date and time to copy an entry to
Calendar Switch from Icon display to Calendar display
display
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Item

Operation/Description

Icon display

Entries in category of selected icon appear
> Select an icon

Tasks

Make quick notes of task to manage in Task list.

Set secret Activate/deactivate Secret Mode o

mode/ > YES (= For Set secret mode, enter Phone Password) I Savmg a Task

Release ® Secret entries appear only in Secret Mode or -

secret Secret Data Only (¥P.11-9). Main Menu p Tools p> Tasks

Compose Create S! Mail by copying event date and content to :

S! Mgil message text (C;Fro[r;yStgep 2 on P.13-4) 1 [NeW] — Select an item (See below)

Send Ir data  (C5P.10-3) ® To check saved Tasks, select a Task. To edit, press (¢)[Edit] in detail

Sendalllr  (£%P.10-3) window.

data Item Operation/Description

IC (C¥P.10-5) Edit Tasks > Enter content

transmission Due date > Select how to enter due date = Enter due date

AllIC (C%P.10-5) ® Select Mo date to enter none.

transmission Priority > Select a priority level

Copy to Copy an entry to microSD Card Category > Select a category

microSD > YES Alarm > Select an Alarm type (= For ON/Set time, enter time)
® To display data on microSD Card: £%P.9-18 ® Alarm Tone: £%P.12-6

Delete this > YES Alarm tone > Select an Alarm tone type = Select a folder =

Delete past  Delete past entries/items, prior to highlighted date Select an Alarm tone

> Select a category to delete = YES

Delete select

> Check entries to delete = (=)[Finish] - YES

2 (=)[Finish]

® \When content is not entered, Tasks cannot be saved.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set C%P.11-5).

g
=2
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I Using Tasks
In Tasks window, press (37)[Menu] for following operations.
Item Operation/Description
New Create a new entry (C3P.12-5)
Edit Edit an entry %P.12-5)
Change Change status indicator shown in Tasks list
status > Select a status (= For Completion, select an item —
Enter Completion date)
® Overdue status indicator turns red.
Show by > Select a category
category
Sort/Filter Sort list by due date, entry order, status, etc.
> Select a condition
Add shortcut Create a shortcut (C%P.1-22)
icon
Send Ir data (%P.10-3)
Send all Ir ([C%P.10-3)
data
IC transmission (C%P.10-5)
AlllC (C%P.10-5)
transmission
Copy to Copy a Task to microSD Card
microSD >YES
® To display data on microSD Card: C5P.9-18
Delete this > YES
Delete select > Check entries = (=)[Finish] - YES
Delete Delete an entry in Completion status
completed >YES
Delete all > Enter Phone Password = YES

\H

Alarms
IAIarm Tone

When scheduled time arrives, alarm tone sounds and

Notification Light illuminates.

@ For Calendar events and Tasks, alarm message and animation
corresponding to selected icon appear on Display.

To Stop Alarm Tone for Calendar Events, Tasks or Alarm
Press any key.

Missed Alarm

"Missed Alarm" Event Indicator appears in Standby for alarms missed
during Privacy Key Lock, Personal Data Lock or Infrared transmission once
locks are canceled or transmission ends. Select indicator to view content.

® When one or more Alarms are set to the same time, alarm sounds in
the order of : "Alarm" = "Timer Recording" = "Tasks" = "Calendar”
= "Timer Watching"
For Tasks, "Missed Alarm" indicator appears.
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I Setting Alarm

Set up to 12 alarms. Alarm tone sounds at the specified time
once, everyday or weekly as set.
® @ appears in Standby when Alarm is set.

Main Menu p> Tools »> Alarms

1 Highlight an Alarm — (=)[Edit]

‘@Alarm OFF
OTime ==t
CORepeat OFF|
»Tone rm Tone|
"@AIarmJﬁBDLevel 4
& Snooze OFF|

@Prefer manner mode ON|

2 Select an item (See below)

Item Operation/Description

Alarm (Alarm Activate or cancel Alarm
on/off) > ON or OFF

Time setting > Set Alarm time

Repeat > Select a repetition (= For Select day, check days =
(=)[Finish])
Alarm tone > Select an Alarm tone type = Select a folder =

Select an Alarm tone

Alarms (Alarm > (@) to set Alarm tone volume

volume)

Snooze When Snooze is set to ON, Alarm tone sounds for 60
setting seconds, repeating up to six times at five minute intervals.
> ON or OFF (= For OFF, enter time)

Prefer Set Manner Mode or Alarm priority.

manner mode > ON or OFF

3 (&2)[Finish]

Alarm Indicators
® Following indicators appear:

: Repeats daily : Repeats weekly

I Cancel & Reactivate Alarm

> In Step 1 (highlight an Alarm), (7)[Menu] - Select an item
® Cancel or reactivate an alarm entry as required.

@ Highlight an entry = () to reactivate/cancel Alarm.

Snooze Function
If ON, press any key; Snooze window appears. To cancel Alarm, press (=).

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.11-5).

sjooL ﬂ
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Calculator Notepad

® Up to 10 digits can be shown. Save up to 20 notes.
Main Menu p> Tools > Calculator .
Saving a Note
Operation Assigned key
Number (0-9) | (0 - () Main Menu p> Tools P> Notepad
+ © 1 <Not Recorded> G Notenad 172
) [1] <Not Recorded> |
- © ® Select a saved note to view content. 2] énot Recorded;
X ® (®[Edit] to edit g dot Revorded
@ E Enm gecorgeg;
- ot Recorde
2 Enter text = w
= ® 0 @ Up to 256 double-byte or 512 single-byte [E Not ;3
" " El <Not Recorded>
Decimal point characters can be entered. @ <Not Recorded>
| — . £ <Not Recorded>
% - B <Not Recorded>
Clear M <Not Recorded>
atm [ tenu |
Example:
-17+28.5=11.5 Notepads Window
© €] ®
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I Notepad Functions Osaifu Keitai®

"Osaifu-Keitai®" is a range of IC Card-based services used

In Notepad list wind x7)[M for followi tions. - L ¢
n Notepad list window, press () Menu for following operations by Osaifu-Keitai® compatible handsets. Make purchases

ftem Operation/Description using e-money or e-ticketing. Hold handset up to a reader/
Edit Edit a saved note writer to pay for your purchase.
Compose Create S! Mail by copying content to message text
S! Mail (CFrom Step 2 on P.13-4) M Osaifu-Keitai® Terms
Edit schedule Copy a note to Schedule to create a Calendar event Osaifu- A contactless IC Card technology to read/write data by
> Schedule — Save a new note (Cfrom Step 2 on Keitai® holding an IC card up to a reader/writer
P12-2) IC Card An IC chip embedded in Osaifu-Keitai®-compatible handsets
Add shortcut Create a shortcut (C%P.1-22) = — - — —
icon Llfesjcyle- Appllcatlons to use Osaifu-Keitai®. Some applications are
Send Ir data (©5P103) Appli preinstalled.
Send all Ir (%P.10-3) Precautions
data
IC (P.10-5) ® Data saved in IC Card vary by service content and usage history.
transmission Procedures to delete IC Card data vary by Lifestyle-Appli. Contact
AlliC (C%P.10-5) Osaifu-Keitai® service providers for details.
transmission ® SoftBank is not liable for damages from accidental loss or alteration of IC
Copy to Copy a note to microSD Card Card data or settings.
microSD >YES ® |C Card data can be misused if your Osaifu-Keitai® compatible handset is
® To display data on microSD Card: (5°P.9-18 lost or stolen. SoftBank is not liable for any resulting damages.
Notepad Info  Display entry date, latest modified date and category of ® Downloading Lifestyle-Appli and using applications may incur high
note packet transmission charges.

Category > Select a category
® When no category applies, select None.
Delete this > VYES

Delete > Check notes = (=)[Finish] = YES
selected

Delete all > Enter Phone Password = YES

sjoo} ﬂ
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Getting Started
Downloading Lifestyle-Appli

Download Lifestyle-Appli via Internet website.

\H

I Downloading Lifestyle-Appli

Main Menu p> Tools p> Osaifu-Keitai p> Lifestyle-Appli

D 4
—— Registration/Settings

Activate Lifestyle-Appli to complete registration or customize
settings.
® Make deposit into account, check payment records or balance, etc.

1 Download - YES

2 SelectaLifestyle-Appli
® Lifestyle-Appli is saved to Data Folder.

I Activating Lifestyle-Appli

® Keep a copy of service passwords/customer service contact, etc. in a
separate place.

® Lifestyle-Appli cannot be activated during a call or while another
S! Appliis active.

13-10

Main Menu p> Tools > Osaifu-Keitai p> Lifestyle-Appli
1 Selecta Lifestyle-Appli

2 Toexit, (=) - Stopped

® Alternatively, Main Menu > S! Appli »> Osaifu-Keitai
b Lifestyle-Appli
or
Main Menu p> Data Folder ) Lifestyle-Appli




I Reader/Writer Transactions

® Complete registration/settings and charge your account beforehand.
® There is no need to activate a Lifestyle-Appli during transaction.

1 Hold 2] logo up to reader/writer

@ When IC Card Notification Light is ON, £2) logo
Notification Light illuminates (%P.18-10). .
@ Hold handset parallel to reader/writer. ffﬁ"/

Try moving handset around if recognition is g
slow. ‘
® Check scan result on reader/writer display.
® Osaifu-Keitai® can be used during a call or
Internet transmission (May require extra
time.).

\H

_Note |

® Data may be unreadable if a metal object, etc. is between /) logo and
reader/writer.

® Even though Osaifu-Keitai® is available while handset is off, Lifestyle-
Appli does not activate. However, if battery is left uncharged after
warning tone sounds, Osaifu-Keitai® may become disabled. Charge
battery beforehand.

® When handset is held up to reader/writer, handset may show a message
or vibrate depending on service. S! Appli, Messaging or Internet may
also activate automatically. To avoid such cases, set the functions not to
activate during transactions (C%P.18-21).

P ececcccccccccccccccccee

(ETIFD @Disable Handset Response to Commands from Reader/Writer
([C%P.18-21)

g
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I IC Card Lock
Activating IC Card Lock

<Default> OFF
® While set, ¥ appears in Standby.

1 Pressand hold = Enter Phone Password

® Repeat the step as required to unlock.

® Alternatively, Main Menu p> Tools p> Osaifu-Keitai
P> IC Card Settings > IC Card Lock or Main Menu p> Settings
» Security »> IC Card Lock

sjooL E
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Remote Lock

<Default> OFF
@ Save up to three phone numbers to enable Remote Lock.

Main Menu P Tools p- Osaifu-Keitai P> IC Card Settings
» Remote Lock

1 Enter Phone Password = ON

2 Select an item (See below)

Item Operation/Description

Numbers to Save numbers to activate Remote Lock

Permit > <Not Recorded> — Enter phone numbers =
(&@)[Return]

@ To save numbers from Phone Book/Incoming Call

Logs or to use a payphone number: (3)[Menu] -
Refer to or Payphone

# of Incoming  Specify the number of incoming calls for activating IC

Call Card Lock

> Enter a number

3 =iset]
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Activating Remote Lock

(DCall 940P from one of the specified numbers (Send Caller ID)

(@Hang up after 940P receives the call

(®Repeat M-@ until specified number of incoming calls is reached (within
three minutes)

® After specified number of incoming calls, IC Card Lock is set and a
message informs you IC Card Lock is activated.

_Note |

® When setting IC Card Lock, call 940P from the same specified phone
number. Incoming calls from different phone numbers cannot be
counted.

® Specified incoming calls may not be counted when Call Forwarding is
active.

® Remote Lock is not available when ring time for Answer Phone is set to
0 or Driving Mode is active.

® \When Answer Phone activates, counted number of incoming calls are
reset.

Dictionary (Japanese)

Use —% 4 TOOL<EE> to access dictionaries (i 52 /\
A0 - FOTEEEE and 2 EEEREE).
® 7 —% A TOOL<EEE> is an S! Appli.

Main Menu p> Tools > Dictionary

1 Read s&& (disclaimer) = OK

T —% A TOOL<EFE> activates.

® To disable Z2&:
Uncheck 77 7 U EEBIRFIC B2 IC 2 9 Bo (Always show
disclaimer when accessing dictionaries)

2 (*) - Enter a word
Search results appear.
@ To scroll pages: (1D/(3)
® To switch dictionaries: ©)/(a)
® To search again: (/)[R 3]
3 Select a word
Details appear.

4 Toend, - Stopped

sjooL a

@ While Dictionary application is active, press (&)[% = 2 —] for useful
functions.
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Sound Recorders
IVoice Recorder

Set recorded sounds for ringtones.
@ Record for about 60 seconds each.

Main Menu p> Tools > Sound Recorders > Voice Recorder
YES

Recording starts.

2 ()[Stop)/@79/(=) (= OK) to stop recording

Recorded sounds are saved in Ring Songs&Tones folder.

13-14
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I Voice Announce

Set recorded sound for on hold tone/holding tone, Alarm,

Calendar event alarm, Tasks alarm, ringtones, Answer Phone

message, Timer Watching (Digital TV), Ring Songs&Tones

Play List.

@ Record only one item for about 15 seconds.

® Select Voice Announce in individual window to set Voice Announce as
specific tone.

Main Menu P> Tools > Sound Recorders P> Voice Announce

1 Record

Recording starts.
Tone beeps five seconds before recording ends.

2 (®)[Stop] to end recording
Tone beeps twice and previous screen returns.
® To play back: Play
® To delete: Frase = YES



Bar Code Reader

Scan barcodes (JAN) or QR Codes with built-in camera.
Access websites, send messages, etc. from QR Codes.

JAN Codes
JAN Code is a one-dimensional bar code denoting numerals with bars
and spaces of different widths.

QR Codes

QR Code is a two-dimensional bar code containing
information.

Example: SoftBank mobile phones
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I Scanning Barcodes

® Up to five items can be saved.
@ For split data, up to 16 QR Codes can be scanned at a time and saved as
one item.

Main Menu p> Tools b Bar Code Reader p> Scan Barcodes

1

Frame barcode in the center of Display

® To adjust Display brightness: (7)[Menu] = Brightness —
Adjust to -3 (dark) - +3 (light)

® To zoom: €

® To use Focus Lock: (2)
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2 (o)[Start]

Scanning starts, and scanned results appear when completed.
® For split data, OK = Repeat Step 1 and 2

® To use scanned data: C%Step 2 on P.12-12

(x7)[Menu] - Save result » OK

® To start over: - YES

® 940P cannot read barcodes or two-dimensional codes other than JAN/
QR Codes.

® Some barcodes cannot be read depending on code type or size.

@ Barcode recognition may be slow. Hold handset steady while scanning.

® Barcodes may not be correctly read owing to scratch, dirt, damage,
quality of printed material, light reflection, or QR code version.
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IViewing/Editing Scanned Data

Main Menu p> Tools > Bar Code Reader p> Saved Data List
1 View
Select an item
Edit Title
Highlight an item — (x7)[Menu] — Edit title - Edit
M Delete Saved Data

> In Step 1, (highlight an item =) (7)[Menu] - Delete — Delete this
or Delete all (= For Delete all, enter Phone Password) = YES
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I Using Scanned Data

Main Menu p> Tools > Bar Code Reader p> Saved Data List

1 Select an item

2 (x7)[Menu] = Select an item (See below)

Item Operation/Description
Save result  Save scanned results
Display list  Display Saved Data List
Internet Connect to URL
> Yahoo! Keitai or PC Site Browser = YES
® Alternatively, select URL to connect to Internet.
Compose Create S! Mail to selected address (%From Step 4 on
S! Mail P.13-4)
® Alternatively, select address to create S! Mail.
Dialing Call selected phone number
> Select a dialing method = Dial
® Alternatively, select phone number to dial.
Add to Save scanned results to Phone Book (C%From Step 2 on
Phone Book P.4-5)
Add Save URL to Bookmark
bookmark > YES —» (2)[0K]
Copy Copy selected characters to another place (Z3From Step 2

on P.3-9)




TBD
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